Operating AVT cameras with SmartView

V2.3.1
27 June 2011
Legal notice

Trademarks
Unless stated otherwise, all trademarks appearing in this document of Allied Vision Technologies are brands protected by law.

Warranty
The information provided by Allied Vision Technologies is supplied without any guarantees or warranty whatsoever, be it specific or implicit. Also excluded are all implicit warranties concerning the negotiability, the suitability for specific applications or the non-breaking of laws and patents. Even if we assume that the information supplied to us is accurate, errors and inaccuracy may still occur.

Copyright
All texts, pictures and graphics are protected by copyright and other laws protecting intellectual property. It is not permitted to copy or modify them for trade use or transfer, nor may they be used on web sites.

Allied Vision Technologies GmbH 06/2011
All rights reserved.
Managing Director: Mr. Frank Grube
Tax ID: DE 184383113
Headquarters:
Taschenweg 2A
D-07646 Stadtroda, Germany
Tel.: +49 (0)36428 6770
Fax: +49 (0)36428 677-28
e-mail: info@alliedvisiontec.com
Contents

Introduction ............................................................................................................ 7
  Document history ................................................................................................. 7
  Conventions used in this manual .......................................................................... 13
  Styles ................................................................................................................... 13
  Symbols ................................................................................................................ 13
  Before operation .................................................................................................. 14

AVT SmartView for FirePackage ............................................................................ 15
  Hardware conditions ............................................................................................. 15
    FireWire hot-plug and screw-lock precautions .................................................... 15
  Supported operating systems ............................................................................... 16
  Overview FirePackage .......................................................................................... 16
  Installing IEEE 1394 adapter .............................................................................. 16
  Installing FirePackage (incl. SmartView program) ............................................... 17
  Turn off PC or laptop ............................................................................................ 17
  Connecting camera to PC or laptop ..................................................................... 17
  Switch on PC or laptop ......................................................................................... 18
  Starting SmartView .............................................................................................. 18
  Licensing ............................................................................................................. 19
  First steps with SmartView .................................................................................. 20
    Overview: SmartView entry window .................................................................. 21
  Troubleshooting .................................................................................................... 25
  Icon bar of SmartView (main window) ................................................................. 26
  Menu structure of SmartView (main window) ....................................................... 31
  Edit settings window (for specialists) ................................................................... 37
    Where to find ...................................................................................................... 37
    Overview: Edit settings window ......................................................................... 37
    Format tab descriptions ...................................................................................... 38
    Ctrl 1 tab descriptions ....................................................................................... 40
    Ctrl 2 tab descriptions ....................................................................................... 42
    Ctrl3 tab descriptions (only color progressive) .................................................. 44
      Progressive cameras ....................................................................................... 44
    Ctrl3 tab descriptions (only color interlaced) .................................................... 45
      Interlaced cameras ......................................................................................... 45
    Trig/IO tab descriptions ..................................................................................... 46
    LUT/Shdg. tab descriptions ................................................................................. 49
    Adv 1 tab descriptions ....................................................................................... 51
    Adv 2 tab descriptions ....................................................................................... 53
    Adv 3 tab descriptions ....................................................................................... 56
    Adv 4 tab descriptions (only Stingray) ............................................................... 57
    Adv 4 tab descriptions (Defect pixel correction: only Pike) ............................... 57
**Operating AVT cameras with SmartView**

- Debayering algorithms ................................................................. 63
  - Conditions ................................................................................. 63
  - Where to find ........................................................................... 63
  - Description ............................................................................... 64
    - Additional adjustment of hue and saturation ......................... 65
- Advanced white balance (only Guppy color interlaced) ................. 66
  - Conditions ................................................................................. 66
  - Where to find ........................................................................... 66
  - Description ............................................................................... 66
- Saving and streaming images ........................................................ 68
  - Conditions ................................................................................. 68
  - Where to find ........................................................................... 68
  - Description ............................................................................... 68
  - Saving images to hard disk or network drive ......................... 68
  - Streaming images: recording options .................................... 70
  - Using deep images (only MONO12/16 mode or RAW12/16 color mode) ............................................................................... 71
- Loading and saving camera settings as XML files ......................... 73
  - Conditions ................................................................................. 73
  - Where to find ........................................................................... 73
  - Description ............................................................................... 74
- Working with the histogram function (SmartView feature only) .... 75
  - Conditions ................................................................................. 75
  - Where to find ........................................................................... 75
  - Description ............................................................................... 75
    - Using histogram ..................................................................... 77
- Working with shading .................................................................... 77
  - Additional information .............................................................. 78
  - Conditions ................................................................................. 78
  - Where to find ........................................................................... 78
  - Description ............................................................................... 79
    - How to prepare for shading image ........................................ 80
    - How to load a shading image out of the camera ................... 81
    - How to load a shading image into the camera ....................... 83
- Working with LUTs ..................................................................... 84
  - Conditions ................................................................................. 84
  - Where to find ........................................................................... 84
  - Description ............................................................................... 85
    - Using AVT's spreadsheet LUTs (camera family dependent) .... 86
    - Using SmartView's built-in LUTs ........................................... 87
    - Using LUT editor with built-in viewer: Overview ................. 90
    - LUT editor: How to select data ............................................. 97
    - LUT editor: How to extend a selection of data ...................... 98
    - LUT editor: New grip point mechanism ............................... 98
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with trigger</td>
<td>101</td>
</tr>
<tr>
<td>Conditions</td>
<td>101</td>
</tr>
<tr>
<td>Where to find</td>
<td>101</td>
</tr>
<tr>
<td>Description</td>
<td>101</td>
</tr>
<tr>
<td>Configuring trigger modes</td>
<td>102</td>
</tr>
<tr>
<td>Scenarios for trigger modes</td>
<td>104</td>
</tr>
<tr>
<td>Configuring input/output pins</td>
<td>104</td>
</tr>
<tr>
<td>Using HDR mode (CMOS cameras)</td>
<td>111</td>
</tr>
<tr>
<td>Conditions</td>
<td>111</td>
</tr>
<tr>
<td>Where to find</td>
<td>111</td>
</tr>
<tr>
<td>Description</td>
<td>111</td>
</tr>
<tr>
<td>Guppy F-036: Micron MV022 HDR mode</td>
<td>111</td>
</tr>
<tr>
<td>Marlin F-131: IBIS5B HDR mode</td>
<td>112</td>
</tr>
<tr>
<td>Error Messages and FirePackage Error Flags</td>
<td>114</td>
</tr>
<tr>
<td>Error codes returned by functions</td>
<td>116</td>
</tr>
<tr>
<td>HALER_xxx codes</td>
<td>116</td>
</tr>
<tr>
<td>FCE_xxx codes</td>
<td>117</td>
</tr>
<tr>
<td>Error flags in global error field</td>
<td>118</td>
</tr>
<tr>
<td>HALERF_xxx</td>
<td>118</td>
</tr>
<tr>
<td>Setting AOI (Format_7 settings)</td>
<td>120</td>
</tr>
<tr>
<td>Conditions</td>
<td>120</td>
</tr>
<tr>
<td>Where to find</td>
<td>120</td>
</tr>
<tr>
<td>Description</td>
<td>121</td>
</tr>
<tr>
<td>Calculating frames per second</td>
<td>123</td>
</tr>
<tr>
<td>Conditions</td>
<td>123</td>
</tr>
<tr>
<td>Where to find</td>
<td>123</td>
</tr>
<tr>
<td>Description</td>
<td>123</td>
</tr>
<tr>
<td>New Frame rate calculation</td>
<td>123</td>
</tr>
<tr>
<td>Example: calculation of frame rate (SmartView vs. Camera)</td>
<td>123</td>
</tr>
<tr>
<td>Status bar counters</td>
<td>124</td>
</tr>
<tr>
<td>Conditions</td>
<td>124</td>
</tr>
<tr>
<td>Where to find</td>
<td>124</td>
</tr>
<tr>
<td>Description</td>
<td>124</td>
</tr>
<tr>
<td>Format_7 mode mapping (only Stingray/Pike/Guppy PRO F-503)</td>
<td>126</td>
</tr>
</tbody>
</table>
Conditions .................................................................................................................. 126
Where to find .................................................................................................................. 126
Description ...................................................................................................................... 127

Packed 12-Bit Modes
(only Stingray/Pike/Guppy PRO) .................................................................................. 130
Conditions ...................................................................................................................... 130
Where to find .................................................................................................................. 130
Description ...................................................................................................................... 130

Sequence mode (Stingray, Pike, Marlin) ......................................................................... 131
Additional information ................................................................................................... 131
Conditions ...................................................................................................................... 131
Where to find .................................................................................................................. 132
Description ...................................................................................................................... 132

Secure image signature (SIS) (Marlin, Pike, Stingray) ....................................................... 134
Additional information ................................................................................................... 134
Conditions ...................................................................................................................... 134
Where to find .................................................................................................................. 135
Description ...................................................................................................................... 135

Smear reduction (only Pike) ............................................................................................ 136
Additional information ................................................................................................... 136
Conditions ...................................................................................................................... 136
Where to find .................................................................................................................. 136
Description ...................................................................................................................... 136
## Introduction

### Document history

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>V2.0.0</td>
<td>28.08.2007</td>
<td>New Manual - RELEASE status</td>
</tr>
<tr>
<td>V2.1.0</td>
<td>11.04.2008</td>
<td>Added Marlin camera in Chapter Sequence mode (Stingray, Pike, Marlin) on page 131</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corrected screenshot in Figure 20: Properties dialog of SmartView on page 107 (...AVT_SmartView_1_7.exe&quot; -i)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added Chapter FireWire hot-plug and screw-lock precautions on page 15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Revised Chapter Licensing on page 19</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Revised Chapter LUT/Shdg. tab descriptions on page 49</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Revised Chapter Working with LUTs on page 84</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added Chapter Using LUT editor with built-in viewer: Overview on page 90</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Changed screenshots from SmartView 1.7 to 1.8 in Chapter AVT SmartView for FirePackage on page 15ff. and in Chapter Operating AVT cameras with SmartView on page 63ff.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New zoom out function and new button original image size on page 28. New zoom functions (zoom in/out/min/max) on page 33.</td>
</tr>
<tr>
<td>V2.2.0</td>
<td>16.10.08</td>
<td>New LUT editor and operation of LUT editor changed: see Chapter Working with LUTs on page 84ff.</td>
</tr>
</tbody>
</table>

Table 1: Document history

to be continued on next page
### Version 2.3.0, 14.01.11

#### Minor corrections

**Switch off PC or laptop before connecting camera:**
- see Chapter *Turn off PC or laptop* on page 17
- see Chapter *Connecting camera to PC or laptop* on page 17
- see Chapter *Connecting camera to PC or laptop* on page 17

#### New features from Stingray update round:

- Disable LEDs: see *Table 17: SmartView Edit settings: Adv 3 tab* on page 56
- Software trigger: see *Software trigger* on page 48

#### New features for Pike cameras having KODAK sensors with two channels (Pike F-032/Pike F-210/Pike F-421/Pike F-505)

- Dual-tap offset adjustment:
  - see *Adjust channels... Alt+Ctrl+A* on page 35

#### Deleted Dolphin (discontinuation) and added Stingray cameras:

- Added *Stingray* and *Marlin* cameras in description of *Sequence dialog...* on page 35
- Added *Stingray*, deleted *Dolphin* in Chapter *Overview: Edit settings window* on page 37
- Added *Stingray* cameras in description of *High SNR mode* on page 38
- Added *Stingray*, deleted *Dolphin* in *Sharpness* on page 42
- Added *Stingray*, deleted *Dolphin* in *Deferred transport* on page 52
- Deleted *Dolphin* (Local color anti-aliasing) in section *Color* on page 54
- Deleted *Dolphin* in *Table 21: Description of debayering algorithms* on page 64
- Deleted *Dolphin* in *Table 27: Recommended number of images for shading data* on page 81

---

Table 1: Document history
Table 1: Document history
Revised all chapters to fit with SmartView 1.12

**New file format:**
- Converted file format from FM7 to FM9

**Changed naming conventions:**
- FirePackage means now: 32-bit and 64-bit versions. The name FirePackage64 is not used any more due to developers reasons.

**Added Windows 7 support (deleted Windows NT and Windows 2000):**
- See Chapter Supported operating systems on page 16 and Chapter Installing IEEE 1394 adapter on page 16

**Added/revised items due to SmartView update rounds:**
- New screenshot of SmartView entry window (the serial number is listed now instead of the vendor for AVT cameras. Example: Instead of Pike F032C(AVT) now Pike F032C(#26789123) is listed.) See Figure 1: SmartView entry window: example of Pike F-145B fiber on page 20
- Save and Record functions are now also available during acquiring images: see Table 6: Functions of SmartView available via icon bar on page 26ff.
- New function Low noise binning on Format tab. New screenshot: see Figure 2: SmartView: example of Edit Settings dialog (Pike F-505B) on page 29
- The following entry has vanished from Menu: View ➔ Additional information: Secure Image Stamp Info and moved to Extras ➔ Show SIS data. See Table 7: Functions of SmartView available via menu on page 31ff.
- Set minimum zoom was deleted and replaced with Set neutral zoom (incl. icon). See Table 7: Functions of SmartView available via menu on page 31ff.
- View Secure Image Stamp info renamed to Show SIS data in Menu Extras: See Table 7: Functions of SmartView available via menu on page 31ff.
- Inserted Low noise binning in Format tab: see Low noise binning on page 39
- Inserted Software trigger modes (-SW) in Table 13: SmartView Edit settings: Trig/IO tab on page 46

Table 1: Document history
### Table 1: Document history

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>V2.3.0</td>
<td>14.01.11</td>
<td>Added/revised items due to SmartView update rounds [continued …]:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- In Trig/IO tab descriptions added <strong>Period/Width/Debounce</strong> column (all 3: PWM features): see <strong>Period column on page 48</strong>; see <strong>Width column on page 48</strong>; see <strong>Debounce column on page 48</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Deep images</strong> can be used also with <strong>MONO12/RAW12 modes</strong> and <strong>Packed 12-Bit Mode</strong> is available with Stingray/Guppy/Guppy PRO models: see Chapter <strong>Using deep images (only MONO12/16 mode or RAW12/16 color mode)</strong> on page 71</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Reorganized the following table: see <strong>Table 25: Which cameras can use deep images?</strong> on page 72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added <strong>Stingray</strong> and deleted <strong>Dolphin</strong> in Chapter <strong>Working with shading</strong> on page 77ff.: see Chapter <strong>Additional information</strong> on page 78 and Chapter <strong>Conditions</strong> on page 78</td>
</tr>
</tbody>
</table>

**Added/revised items due to SmartView update rounds [continued …]:**
- Added **Adv4 tab**: see Chapter **Adv 4 tab descriptions (only Stingray)** on page 57
- Added **RAW8** condition for hue and saturation: see **Only RAW8 formats: additional adjustment of hue and saturation possible (using methods YUV422/LCAA/LCAA+V):** on page 63
- Additional adjustment of **hue and saturation** does not depend on specific camera family but on **RAW8 format**, see Chapter **Additional adjustment of hue and saturation** on page 65
- Added new namings of **Edge mode**, **Level mode**, **Progr. mode** (incl. **-Ext** for external trigger; **-SW** for software trigger) in **Table 36: Description of trigger modes** on page 102
- Added log level **"-d"** for debug in Chapter **Using logging functionality of SmartView (*.cmd file)** on page 106
- New screenshot for AFE channel adjustment (not only gain adjustment but also **offset adjustment**): see **Figure 22: Channel balance: Example (Pike F-032C)** on page 108
- Revised description of channel balance (not only gain adjustment but also **offset adjustment**): see Chapter **Pike channel balance** on page 108ff.
## Table 1: Document history

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Remarks</th>
</tr>
</thead>
</table>
| V2.3.1  | 27.06.11 | Defect pixel correction for Pike F-1100/1600 and Guppy F-503 / Guppy PRO F-503:  
|         |        | • Added Note **Defect pixel correction** with cross reference to *Pike Technical Manual* in Chapter Adv 4 tab descriptions (Defect pixel correction: only Pike) on page 57.  
|         |        | • Added description **Defect Pixel Correction (only Guppy F-503 and Guppy PRO F-503)** on page 60  
|         |        | Marked features (incl. index) that are not camera features, which means they are only available inside SmartView:  
|         |        | • Auto Chn. see **ISO channel** on page 39  
|         |        | • **Frame buffers** on page 39  
|         |        | • **Debayering** on page 38  
|         |        | • **Extra features during debayering** on page 44  
|         |        | • **Hue** on page 44  
|         |        | • **Saturation** on page 44  
|         |        | • **HDR: Easy mode** on page 59  
|         |        | • Chapter **Working with the histogram function (SmartView feature only)** on page 75  
|         |        | Smaller corrections:  
|         |        | • Corrected: GRBG instead of GRGB in *Table 22: Description of BAYER patterns* on page 65  
|         |        | • Revised Chapter **Using deep images (only MONO12/16 mode or RAW12/16 color mode)** on page 71  
|         |        | to be continued on next page
Conventions used in this manual

To give this manual an easily understood layout and to emphasize important information, the following typographical styles and symbols are used:

Styles

<table>
<thead>
<tr>
<th>Style</th>
<th>Function</th>
<th>Example</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Programs, inputs or highlighting important things</td>
<td>bold</td>
<td>bold</td>
</tr>
<tr>
<td>Courier</td>
<td>Code listings etc.</td>
<td>Input</td>
<td>Input</td>
</tr>
<tr>
<td>Upper case</td>
<td>Register</td>
<td>REGISTER</td>
<td>REGISTER</td>
</tr>
<tr>
<td>Italics</td>
<td>Modes, fields</td>
<td>Mode</td>
<td>Mode</td>
</tr>
<tr>
<td>Parentheses and/or blue</td>
<td>Links</td>
<td>(Link)</td>
<td>(Link)</td>
</tr>
</tbody>
</table>

Table 2: Styles

Symbols

Note

This symbol highlights important information.

Caution

This symbol highlights important instructions. You have to follow these instructions to avoid malfunctions.

www

This symbol highlights URLs for further information. The URL itself is shown in blue.

Example:

http://www.alliedvisiontec.com
Before operation

The FirePackage SmartView Manual is the guide to the installation of the software and the operation of AVT cameras with SmartView.

**Note** Please read through this manual carefully before operating AVT cameras with SmartView.
AVT SmartView for FirePackage

In this manual FirePackage means both: 32-bit version as well as 64-bit version.

Hardware conditions

- PC or laptop with built-in IEEE 1394 interface
- IEEE 1394 adapter (OHCI) card for PCI bus or PCI Express bus or PC card or ExpressCard with IEEE 1394 port(s)

Note AVT offers a wide range of IEEE 1394 adapters, both 1394a or 1394b for different requirements.

FireWire hot-plug and screw-lock precautions

Caution Hot-plug precautions

- Although FireWire devices can theoretically be hot-plugged without powering down equipment, we strongly recommend turning the computer power off, before connecting a digital camera to it via a FireWire cable.
- Static electricity or slight plug misalignment during insertion may short-circuit and damage components.
- The physical ports may be damaged by excessive ESD (electrostatic discharge), when connected under powered conditions. It is good practice to ensure proper grounding of computer case and camera case to the same ground potential, before plugging the camera cable into the port of the computer. This ensures that no excessive difference of electrical potential exists between computer and camera.

Screw-lock precautions

- Also, all AVT 1394b camera and cables have industrial screw-lock fasteners, to insure a tight electrical connection that is resistant to vibration and gravity.
- We strongly recommend using only 1394b adapter cards with screw-locks.
Supported operating systems

... for FirePackage:
- Windows XP (32 bit and 64 bit)
- Windows Vista (32 bit and 64 bit)
- Windows 7 (32 bit and 64 bit)

**Note** The AVT FirePackage includes a special IEEE 1394 device driver from INTEK suitable for all AVT cameras which replaces the MS 1394 driver stack completely.

Overview FirePackage

- Install IEEE 1394 adapter (if PC or laptop does not have an IEEE 1394 port)
- Install FirePackage (incl. SmartView)
- Start SmartView
- Connect camera to PC or laptop and ensure that the camera is powered
- License will automatically be read out from your AVT camera (in case of problems, contact AVT support)
- Get your first image with SmartView
- Problems? Read Chapter Troubleshooting on page 25.

Installing IEEE 1394 adapter

**Note** When you install FirePackage the SmartView program will automatically be installed.

1. PC: Install the IEEE 1394 adapter according to the instructions you got from your adapter manufacturer.
   Laptop: Insert the IEEE 1394 PC Card into your laptop. Connect external power supply to the adapter to power the camera or power the camera via Hirose connector.
   Windows XP/ Windows Vista/Windows 7 will detect the hardware automatically and installs a Windows 1394 driver.
Installing FirePackage (incl. SmartView program)

1. Download AVT FirePackage from the AVT website.
2. To start the installation of FirePackage unzip AVT FirePackage x.y.zip
   A wizard will guide you through the installation. To go on click Next in each window.
4. You are asked to choose a directory: Accept the option shown or type another one. Click Next.
5. Activate all 3 check boxes. Click Next to start installation.
   AVT FirePackage is being installed.
   The INTEK window appears.
6. Now install the driver for the IEEE 1394 adapter: for each card to be used with FirePackage, activate the check box.
7. Click Install.
8. Ignore the message box (Microsoft non-certified driver) and continue the installation.
   A wizard will guide you through the installation. To continue click Next in each window.
   A window appears: FirePackage has been successfully installed.
9. Click Close.
   Now the FirePackage and the SmartView Program are installed on your PC or laptop.

Turn off PC or laptop

1. Close all programs.
2. Shutdown Windows.
3. Turn off PC or laptop.

Connecting camera to PC or laptop

1. Insert one end of the FireWire cable into your 1394 adapter or 1394 PC card.
2. Insert the other end of the FireWire cable into your camera.
3. Check that the camera is powered (green LED ON)
Switch on PC or laptop

1. Switch on PC or laptop.
2. Wait until Windows has started.

Starting SmartView

The SmartView program:
• enables access to all connected IEEE 1394 cameras
• supports almost all smart features of the AVT cameras.
1. Click Start → Programs → Allied Vision Technologies → FirePackage → AVT_SmartView
   The SmartView window opens.
2. Here you can see all 1394 buses and PCI slots (e.g. 0x040800).
Licensing

You need a license to run the FirePackage. This license is embedded in each AVT camera. It will be read out with the help of the license file LICENSE.TXT.

Note

Newer versions of AVT FirePackage (> 2V6) use additional registry keys for supplying alternative names and positions for the license file to be stored.

Note

For detailed licensing infos read:

- AVT FirePackage User Guide, Chapter Licensing
First steps with SmartView

1. After connecting the camera with your PC or laptop, start SmartView program. In the SmartView entry window you see all FireWire adapters or cards installed in your PC.

2. In the SmartView entry window open all trees by clicking on the [+] button. Search for your camera and double-click on the camera entry.

3. The SmartView main window opens and usually one first image is shot automatically.

Figure 1: SmartView entry window: example of Pike F-145B fiber
### Overview: SmartView entry window

The menus and icons of the SmartView entry window are explained in the following tables:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Icon](image) | General settings | Opens the **General settings** window (see Table 5: SmartView entry window: General settings on page 23)  
Here you can adjust settings for connecting 1394 cards to the 1394 bus, image type settings and camera view settings. |
| ![Icon](image) | Information  | Shows version and copyright information of AVT SmartView for FirePackage                                                                |

Table 3: SmartView entry window: toolbar
In SmartView entry window click on **Camera → Settings**.

The **General settings** window opens.
<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable initial card states</td>
<td>☐ Enable initial card states</td>
<td>This function is useful, if you have more than one card installed and several cameras. Activate this check box and disable cards you don’t use and set your working card to False, so that connected cameras are shown automatically.</td>
</tr>
<tr>
<td>Card ID list</td>
<td></td>
<td>Lists all 1394 cards (connected to your PC/Laptop) with their ID number. To disable a card, set the Disabled parameter to True. To open the bus when SmartView is started, set the AutoOpen parameter to True. All connected 1394 cameras of this card will be searched and opened automatically.</td>
</tr>
<tr>
<td>Camera</td>
<td>☐ Automatically open camera views on startup</td>
<td>Activate this check box to view all connected cameras automatically, when corresponding card is opened.</td>
</tr>
<tr>
<td>☐ Selected cameras only</td>
<td></td>
<td>Activate this check box to show only selected cameras from the list, when SmartView is started. The list shows all cameras, that have been connected to your PC/laptop and have been opened with SmartView. Select one or more cameras by clicking on the camera name.</td>
</tr>
<tr>
<td>Image file type</td>
<td>Default type used by ‘Save’ &amp; ‘Save as’</td>
<td>Choose your standard image file type for the Save and Save as operation. The following types are available: bmp, jpg, gif, tif, png.</td>
</tr>
<tr>
<td>☐ Override extension entered by the user</td>
<td></td>
<td>If you activate this check box, all settings made within the Save and Save as command are ignored.</td>
</tr>
</tbody>
</table>

Table 5: SmartView entry window: General settings
<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera view settings</td>
<td>☐ Always scale image to view size</td>
<td>Standard setting for each window. Activating this check box will scale the camera image to the SmartView viewer window size. Otherwise the camera image size is not scaled to the viewer window size.</td>
</tr>
<tr>
<td></td>
<td>☐ Resize camera view on resolution changes</td>
<td>Standard setting for each window. Activate this check box to adapt the viewer window to each resolution change of the image size (fixed modes) or the AOI size (Format 7 settings).</td>
</tr>
</tbody>
</table>

Table 5: SmartView entry window: General settings
Troubleshooting

If the image is completely black, completely white or the image quality is poor, then try the following steps:

- If not done yet, remove the lens cap.
- If the image is black, open the aperture. If the image is white, close the aperture.
- If the image quality is poor, try changing the focus.

If you still don’t get any image at all, then try the following steps:

- Check the FireWire plug of your camera and PC/laptop.
- Check the LEDs on the back of the camera.
Icon bar of SmartView (main window)

The following table shows all functions of SmartView (main window) available via the icon bar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Save</td>
<td>Saves the image(s) to the file you have previously set with Save as... command. Also possible during acquiring images (takes more time).</td>
</tr>
<tr>
<td></td>
<td>Edit Settings</td>
<td>Opens a settings window. Here you can adjust the settings for the standard registers, e.g. exposure time or gain (IIDC specification) and the settings for advanced AVT features. The following tabs are available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Format</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ctrl 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ctrl 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ctrl 3 (only for certain color cameras)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Trig/I0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• LUT/Shdg.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Adv 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Adv 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Adv 3 (not all cameras)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Adv 4 (only Stingray)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• CMOS (only for cameras with CMOS sensor)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Some settings can only be changed when the camera is in idle mode.</td>
</tr>
</tbody>
</table>

Table 6: Functions of SmartView available via icon bar
Direct register access
Opens a window (Direct Access dialog box)
For an example see Figure 3: SmartView: example of DirectAccess dialog (Marlin F-080C-30fps) on page 30.
Enables you to access all features by their address and to change the register of the AVT camera directly.
All settings can be changed while the camera is running, although some features will only take effect after you stop and restart the camera.

Start iso
Acquires images continuously

Multi-shot
Acquires multi images as set in the Edit Settings  TriggerI/O tab  Multishot counter combo box

One-shot
Acquires only one image

Stop
Stops acquiring images (free-run or multi-shot)

Record
Records images to individual file names you have set under File  Recording options...
This function can also be used during image acquisition.

Display image coordinates
Displays the image coordinates in a yellow bubble box on top of mouse cursor

Table 6: Functions of SmartView available via icon bar
### Table 6: Functions of SmartView available via icon bar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Display image coordinates and image values</td>
<td>Displays the image coordinates and the image values (intensity) in a yellow bubble box on top of mouse cursor</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Display format options in status bar</td>
<td>Displays the format options in the status bar. Example: 2080x1540x8 (RAW8)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Increase zoom factor</td>
<td>Increases the image zoom factor in 0.1x steps (0.1x, 0.2x, ..., 0.9x) and 1.0x steps (1.0x, 2.0x, ..., 32.0x)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show original image size</td>
<td>Displays the image in original image size (zoom=1.0x)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Decrease zoom factor</td>
<td>Decreases the image zoom factor in 1.0x steps (32.0x, 31.0x, ..., 2.0x, 1.0x) and in 0.1x steps (0.9x, 0.8x, ..., 0.1x)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Quick read settings from file</td>
<td>Reads settings from file to which you have written your settings.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Quick write settings to file</td>
<td>Writes settings to the file you have chosen.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>About</td>
<td>Shows version number, copyright information and link to Allied Vision Technologies: <a href="http://www.alliedvisiontec.com/">http://www.alliedvisiontec.com/</a></td>
</tr>
</tbody>
</table>
Figure 2: SmartView: example of *Edit Settings* dialog (Pike F-505B)
Figure 3: SmartView: example of **DirectAccess** dialog (Marlin F-080C-30fps)
# Menu structure of SmartView (main window)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Submenu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Save</td>
<td>Saves the image(s) to the file you have previously set with <strong>Save as...</strong> command.</td>
</tr>
<tr>
<td></td>
<td>Save as...</td>
<td>Click here to save an image to hard disk or network drive. Choose file format (BMP, JPEG, GIF, TIFF, PNG) and directory. After that you can save an image to this file by clicking on <strong>Save</strong>.</td>
</tr>
<tr>
<td></td>
<td>Recording options...</td>
<td>Click here to configure the recording options. After that you are able to save images in streaming format, that means one file with a successive numbering per image. See Chapter <strong>Streaming images: recording options</strong> on page 70.</td>
</tr>
<tr>
<td></td>
<td>Use deep images</td>
<td>Allows to use images with more than 8 bit (depending on camera model). See Chapter <strong>Using deep images (only MONO12/16 mode or RAW12/16 color mode)</strong> on page 71.</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Click here to exit main window of SmartView.</td>
</tr>
</tbody>
</table>

Table 7: Functions of SmartView available via **menu**
## Camera

<table>
<thead>
<tr>
<th>Submenu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶️ Free-run  Alt+R</td>
<td>Acquire continuous images.</td>
</tr>
<tr>
<td>▶️ Multi-shot  Alt+M</td>
<td>Acquire n images.</td>
</tr>
<tr>
<td>▶️ One-shot  Alt+G</td>
<td>Acquire one image.</td>
</tr>
<tr>
<td>☐ Stop  Esc</td>
<td>Stop the free-run or multi-shot modus.</td>
</tr>
<tr>
<td>☐ Record  Ctrl+R</td>
<td>Record individual images according to the settings you have made in <strong>File → Recording options</strong>... See Chapter Saving and streaming images on page 68.</td>
</tr>
</tbody>
</table>

## Settings

<table>
<thead>
<tr>
<th>Submenu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings →  ▶️ Settings dialog  Alt+E</td>
<td>Opens the <strong>Settings</strong> dialog.  • For short overview see Chapter Edit settings window (for specialists) on page 37.  • For deep description on complex, difficult to understand settings see Chapter Operating AVT cameras with SmartView on page 63.</td>
</tr>
<tr>
<td>Settings →  ☐ Quick Read settings  Ctrl+Shift+R</td>
<td>Reads settings from file to which you have written your settings.</td>
</tr>
<tr>
<td>Settings →  ☐ Quick Write settings  Ctrl+Shift+W</td>
<td>Writes settings to the file you have chosen.</td>
</tr>
<tr>
<td>Settings →  Select Settings file...  Ctrl+Shift+W</td>
<td>Choose a file where your settings will be stored.</td>
</tr>
<tr>
<td>Settings →  Read Settings from external file...</td>
<td>Choose an external file from which the stored settings will be read.</td>
</tr>
<tr>
<td>Settings →  Write Settings to external file...</td>
<td>Choose an external file to which your settings will be stored.</td>
</tr>
<tr>
<td>Settings →  ☐ Search for camera by GUID</td>
<td>Searches by camera ID; Default: activated</td>
</tr>
<tr>
<td>☐ Direct access dialog  Alt+D</td>
<td>Opens a window (Direct Access dialog box) Enables you to access all features by their address and to change the register of the AVT camera directly. All settings can be changed while the camera is running, although some features will only take effect after you stop and restart the camera.</td>
</tr>
</tbody>
</table>

## Options

<table>
<thead>
<tr>
<th>Submenu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options →  ☐ Automatically load settings on camera open</td>
<td>Activate check box to load settings automatically when the camera is opened.</td>
</tr>
<tr>
<td>Options →  ☐ Automatically save settings on camera close</td>
<td>Activate check box to save settings automatically when camera is closed.</td>
</tr>
<tr>
<td>Options →  ☐ Start Free-Run automatically on camera open</td>
<td>Activate check box to start free-run automatically when the camera is opened.</td>
</tr>
<tr>
<td>Options →  ☐ Start One-Shot on camera open</td>
<td>Activate check box to start one-shot when the camera is opened.</td>
</tr>
<tr>
<td>Options →  ☐ Set shutter, gain and white balance automatically</td>
<td>Activate check box to set shutter, gain and white balance automatically.</td>
</tr>
<tr>
<td>Options →  ☐ Start with display maximized on camera open</td>
<td>Activate check box to start with the SmartView display maximized when the camera is opened.</td>
</tr>
</tbody>
</table>
### AVT SmartView for FirePackage

**Table 7: Functions of SmartView available via menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Submenu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View</strong> (cont. on next page)</td>
<td>✔️ Toolbar</td>
<td>Activate check box to display the toolbar.</td>
</tr>
<tr>
<td></td>
<td>✔️ Status bar</td>
<td>Activate check box to display the status bar.</td>
</tr>
<tr>
<td><strong>Set display size to</strong></td>
<td>Current A0I</td>
<td>Alt+9</td>
</tr>
<tr>
<td></td>
<td>Current image size</td>
<td>Alt+8</td>
</tr>
<tr>
<td></td>
<td>Ratio-corrected image size</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td></td>
<td>160x120</td>
<td>Alt+1</td>
</tr>
<tr>
<td></td>
<td>320x240</td>
<td>Alt+2</td>
</tr>
<tr>
<td></td>
<td>640x480</td>
<td>Alt+3</td>
</tr>
<tr>
<td></td>
<td>800x600</td>
<td>Alt+4</td>
</tr>
<tr>
<td></td>
<td>1024x768</td>
<td>Alt+5</td>
</tr>
<tr>
<td></td>
<td>1280x960</td>
<td>Alt+6</td>
</tr>
<tr>
<td></td>
<td>1600x1200</td>
<td>Alt+7</td>
</tr>
<tr>
<td></td>
<td>User size...</td>
<td>Alt+0</td>
</tr>
<tr>
<td><strong>Additional information</strong></td>
<td>The listed formats set the display size of the window and are independent from camera types. If the display of your monitor is smaller than the chosen display size, then the display format is resized automatically to fit to your monitor.</td>
<td></td>
</tr>
<tr>
<td>✔️ Disable display of image</td>
<td>Activate check box to disable the display of an image.</td>
<td></td>
</tr>
<tr>
<td>🔍 Zoom in Alt+&quot;+&quot;</td>
<td>Click here for zooming in an image.</td>
<td></td>
</tr>
<tr>
<td>Each click increases the image zoom factor in 0.1x steps (0.1x, 0.2x, ..., 0.9x) and 1.0x steps (1.0x, 2.0x, ..., 32.0x)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔍 Zoom out Alt+&quot;-&quot;</td>
<td>Click here for zooming out an image.</td>
<td></td>
</tr>
<tr>
<td>Each click decreases the image zoom factor in 1.0x steps (32.0x, 31.0x, ..., 2.0x, 1.0x) and in 0.1x steps (0.9x, 0.8x, ..., 0.1x)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔍 Set neutral zoom Alt+Ctrl+&quot;=&quot;</td>
<td>Click here for setting neutral zoom (zoom factor 1.0).</td>
<td></td>
</tr>
<tr>
<td>Set maximum zoom Alt+Ctrl+&quot;+&quot;</td>
<td>Click here for setting maximum zoom.</td>
<td></td>
</tr>
</tbody>
</table>

*The histogram function is a SmartView feature, but not a camera feature.*
Resize view on format change

Activate this check box to adapt the viewer window to each resolution change of the image size (fixed modes) or the AOI size (Format 7 settings).

Always scale image to window

Activating this check box will scale the camera image to the SmartView viewer window size. Otherwise the camera image size is not scaled to the viewer window size.

Reset position of settings dialog

Click here to reset the position of the settings dialog. Use this if you cannot see the settings windows after starting SmartView.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Submenu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View (cont. from last page)</td>
<td>✓ Resize view on format change</td>
<td>Standard setting for each window. Activate this check box to adapt the viewer window to each resolution change of the image size (fixed modes) or the AOI size (Format 7 settings).</td>
</tr>
<tr>
<td></td>
<td>✓ Always scale image to window Alt+S</td>
<td>Standard setting for each window. Activating this check box will scale the camera image to the SmartView viewer window size. Otherwise the camera image size is not scaled to the viewer window size.</td>
</tr>
<tr>
<td></td>
<td>Reset position of settings dialog</td>
<td>Click here to reset the position of the settings dialog. Use this if you cannot see the settings windows after starting SmartView.</td>
</tr>
</tbody>
</table>

Table 7: Functions of SmartView available via menu
### Table 7: Functions of SmartView available via menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Submenu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extras</td>
<td>Set async speed</td>
<td>The following values are available: S100, S200, S400, S800 (only 1394b cameras). Use manual settings if you want to limit async. communication with camera to lower speed. Helpful in the case of longer cables (e.g. 20 m at S200) or needed for communication over up to 100 m using network cable at S100.</td>
</tr>
<tr>
<td></td>
<td>Allow async block transfer</td>
<td>Disabling async. block transfer may be helpful for the communication with third party cameras.</td>
</tr>
<tr>
<td></td>
<td>Drop faulty frames</td>
<td>Activate check box for dropping defective frames. A frame is called defective, if during transmission of the frame an error occurred.</td>
</tr>
<tr>
<td></td>
<td>Auto-flush logging file</td>
<td>Activate check box for logging messages immediately into logging file. If check box not activated, messages will only be logged when buffer full. For more information see Chapter Using logging functionality of SmartView (*.cmd file) on page 106. Default: not activated</td>
</tr>
<tr>
<td></td>
<td>Adjust channels... Alt+Ctrl+A</td>
<td>Only Pike cameras: see Pike Technical Manual, Chapter: Channel balance Only the following Pike cameras having KODAK sensors with two channels (Pike F-032/Pike F-210/ Pike F-421/Pike F-505): see Pike Technical Manual, Chapter: Channel balance, Subsection: Dual-tap offset adjustment with SmartView (1.10 or greater)</td>
</tr>
<tr>
<td></td>
<td>Show SIS data...</td>
<td>Only Marlin, Pike, Stingray cameras: see Chapter Secure image signature (SIS) (Marlin, Pike, Stingray) on page 134</td>
</tr>
<tr>
<td></td>
<td>Sequence dialog...</td>
<td>Only Stingray, Pike, Marlin cameras: see Chapter Sequence mode (Stingray, Pike, Marlin) on page 131</td>
</tr>
</tbody>
</table>
Table 7: Functions of SmartView available via menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Submenu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>✎ About AVT SmartView...</td>
<td>Shows version number, copyright information and link to Allied Vision Technologies: <a href="http://www.alliedvisiontec.com/">http://www.alliedvisiontec.com/</a></td>
</tr>
<tr>
<td>Help</td>
<td>✔️ Tooltip help for settings</td>
<td>Activate <strong>Tooltip help for settings</strong> to get help when moving mouse cursor over window elements (buttons, lists, check boxes etc. of main window and Edit settings window). You will get tooltips in form of bubble help. Example:</td>
</tr>
</tbody>
</table>

The available/selected fixed resolutions and format 7 modes for this camera:

- **Marlin F131B - AVT [Card 0, Node 0] - AVT SmartView 1.**
- **Format**: 640x480, 800x600, 1024x768, 1280x960, 1300x960
- **Adv 1**: 5 fps, 7.5 fps, 1 fps
- **Adv 2**: 5 fps, 1 fps
- **Adv 3**: 1 fps
- **Adv 4**: 1 fps
- **Adv 5**: 1 fps
- **Adv 6**: 1 fps
- **Adv 7**: 1 fps

Example:
Edit settings window (for specialists)

Where to find

SmartView (main window): Edit settings

Overview: Edit settings window

Note: Display of tabs depends on camera types.
   If a camera does not have tab-specific features implemented, the corresponding tab will not be displayed.

Depending on camera type the following tabs may be displayed:
- Format tab
- Ctrl 1 tab
- Ctrl 2 tab
- Ctrl 3 tab (only Pike/Stingray color cameras and Guppy interlaced color cameras)
- Trig/IO tab
- LUT/Shdg. tab
- Adv 1 tab
- Adv 2 tab
- Adv 3 tab
- Adv 4 tab
- CMOS tab (only CMOS cameras)
## Format tab descriptions

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box/combo box/list/slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed &amp; variable</td>
<td></td>
<td>[to be continued on next page]</td>
</tr>
<tr>
<td>modes...</td>
<td></td>
<td><strong>Format</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lists the fixed resolutions and Format_7 modes of the camera model. Depending on the camera model the following formats may be available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Fixed formats</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 320x240</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 640x480</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 800x600</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 1024x768</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Format_7 modes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- F7 mode 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- F7 mode 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ...</td>
</tr>
<tr>
<td>Color</td>
<td></td>
<td>Lists the available color modes of the selected fixed format / Format_7 mode. Depending on the camera model and the selected resolution / F7 mode the following color modes may be available: Mono8, YUV411, YUV422, RGB8, RAW8, RAW16, RAW12...</td>
</tr>
<tr>
<td>Framerate</td>
<td></td>
<td>Lists available frame rates in fixed modes. List is invalid for Format_7 modes.</td>
</tr>
<tr>
<td>ISO speed</td>
<td></td>
<td>Lists available ISO speeds. 1394a: S100, S200, S400 1394b: additional S800 The camera will use this speed for the video data transmission, async. communication may use another speed. See Submenu Set async speed on page 35.</td>
</tr>
<tr>
<td>Debayering</td>
<td></td>
<td>See Chapter Debayering algorithms on page 63. $\Rightarrow$ Debayering is a SmartView feature, but not a camera feature.</td>
</tr>
<tr>
<td>High SNR mode</td>
<td></td>
<td>Choose number of images for High SNR mode. This is an image averaging function. See Pike/Stingray Technical Manual, Chapter High SNR mode (High Signal Noise Ratio)</td>
</tr>
</tbody>
</table>

Table 8: SmartView Edit settings: **Format** tab
Table 8: SmartView Edit settings: Format tab

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box/combo box/list/slider</th>
<th>Description</th>
</tr>
</thead>
</table>
| Fixed & variable modes... | ISO channel                      | Set no. of ISO channels. (This is a 4-bit address to identify the source of a video data stream). Normally set to **Auto Chn**. Otherwise all cameras connected to one bus must have a different ISO channel.  
  ⇒ Auto Chn. is a SmartView feature, but not a camera feature. |
| Frame buffers            |                                  | By default SmartView reserves 16 **frame buffers** per camera in main memory. You can change that to a max. limit, which is dependent on your system and OS. After changing, SmartView displays how many buffers it currently uses (e.g. 2/786) so as not having to drop any frames coming from the camera.  
  The minimum of 3 ensures that normally no image from camera is to be discarded because of no available memory.  
  ⇒ Frame buffers is a SmartView feature, but not a camera feature, and is automatically saved in the registry (but not in the user sets) when closing SmartView. |
| □ Low noise binning      |                                  | Only Pike/Stingray: Enables/disables low noise binning mode. This means: an average (and not a sum) of the luminance values is calculated within the FPGA.  
  The image is therefore darker than with the usual binning mode, but the signal to noise ratio is better (approximately a factor of \( \sqrt{2} \)). |
<table>
<thead>
<tr>
<th>Section</th>
<th>Check box/combo box/list/slider</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Format7 settings...** (max. abcd x efgh) | Left/Width/Top/Height | These are the **AOI settings** (only available in Format_7 modes)  
For more information see Chapter **Setting AOI (Format_7 settings)** on page 120.  
Adjust **width** and **height** of camera image.  
For images smaller than maximum image dimensions: adjust upper left corner via **left** and **top** position of camera image on image sensor. |
| Packet size                 |                                 | To change packet size first deactivate **Auto size** check box.                                                                          |
| ☐ Auto size                 |                                 | Deactivate check box to adjust **packet size for isochronous packets** (via slider or combo box).  
⇒ **Auto size is a SmartView feature, but not a camera feature, and is automatically saved in the registry (but not in the user sets) when closing SmartView.** |
| Max frame rate              |                                 | Shows the **maximum theoretical frame rate**. See Chapter **Calculating frames per second** on page 123.                                   |

Table 8: SmartView Edit settings: **Format tab**

**Ctrl 1 tab descriptions**

If available, you can do the following:

- Switch on/off the feature, by activating/deactivating the **On** check box.
- Switch on/off auto function, by activating/deactivating the **Auto** check box.
- Do one-push action, by clicking **1x** button.
- Adjust the feature manually by moving the slider or changing the values directly (entering numbers or clicking up/down arrows.)
<table>
<thead>
<tr>
<th>Check box/combo box/list/slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target grey level</td>
<td>This is the auto exposure. Works in conjunction with auto shutter and auto gain. Target grey level corresponds to Auto_exposure register 0xF0F00804 (IIDC). Increasing the auto exposure value (aka target grey value) increases the average brightness in the image and vice versa.</td>
</tr>
<tr>
<td>Shutter</td>
<td>Adjust the electronic shutter <strong>manually.</strong> The set value is to be multiplied by the time base, which can be set here: Check box Timebase on page 51</td>
</tr>
<tr>
<td>Gain</td>
<td>Adjust the gain <strong>manually.</strong> Gain will change on the fly. The possible range depends on the camera model. The value is to be multiplied by a constant factor which is dependent on the camera model. A higher gain produces greater image noise. This reduces image quality. For this reason, try first to increase the brightness, using the aperture of the camera optics and/or longer shutter settings.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Adjusting the brightness <strong>manually</strong> changes the IIDC register brightness at offset 800h. This effectively changes the offset in the image. The range is multiplied by a factor, dependent on the camera model.</td>
</tr>
</tbody>
</table>
| Gamma                         | Switch Gamma off/on 0 = Gamma off 1 = Gamma on  This is a non-linear stretching of the darker parts and compression of the brighter parts in the image to accommodate certain human and display non-linearities. The actual function used is described in the camera manual. When using the LUT feature and the gamma feature pay attention to the following:  
- gamma ON \[\rightarrow\] look-up table is switched ON also  
- gamma OFF \[\rightarrow\] look-up table is switched OFF also  
- look-up table OFF \[\rightarrow\] gamma is switched OFF also  
- look-up table ON \[\rightarrow\] gamma is switched OFF |

Table 9: SmartView Edit settings: **Ctrl 1** tab
### Ctrl 2 tab descriptions

If available (hue/saturation), you can do the following:

- Switch on/off the feature, by activating/deactivating the **On** check box.
- Switch on/off auto function, by activating/deactivating the **Auto** check box.
- Do one-push action, by clicking the button.
- Adjust the feature manually by moving the slider or changing the values directly (entering numbers or clicking up/down arrows.)

<table>
<thead>
<tr>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hue</strong></td>
<td>Adjust <strong>Hue</strong> manually. Hue performs a (slight) global shift of all colors in the image.</td>
</tr>
<tr>
<td><strong>Saturation</strong></td>
<td>Adjust <strong>Saturation</strong> manually. Saturation changes the amount of the coloring from nominal down to zero or up to 200%.</td>
</tr>
</tbody>
</table>

Table 10: SmartView Edit settings: **Ctrl 2** tab
Auto-function AOI

This is a feature to limit the area in which parameters for the auto functions (auto gain, auto shutter, auto white balance) are calculated to a fraction of the image size. Can be used to exclude e.g. the sky from the gain/shutter regulations or perform auto white balance in only a specific subarea of the image.

Switch on/off auto-function AOI by activating/deactivating Enable check box. Off uses the whole image size for autofocus parameters.

Enter values: AOI width/height/left (coordinate) and top (coordinate). Allowed steps are shown in the fields X-Unit/Y-Unit.

To highlight the AOI in the image, activate Show AOI check box.

Auto shutter range

Choose standard (Std.) or extended (Extd.) auto shutter range. Change lower and upper limit to restrict the auto shutter to operate between these limits and not the whole range. Useful for applications where a too long shutter time would cause e.g. motion blurring in the image.

Auto gain range

Change lower and upper limit. Change lower and upper limit to restrict the auto gain to operate between these limits and not the whole range. Useful for applications where a too high gain would cause noise in the image.

<table>
<thead>
<tr>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-function AOI</td>
<td>This is a feature to limit the area in which parameters for the auto functions (auto gain, auto shutter, auto white balance) are calculated to a fraction of the image size. Can be used to exclude e.g. the sky from the gain/shutter regulations or perform auto white balance in only a specific subarea of the image. Switch on/off auto-function AOI by activating/deactivating Enable check box. Off uses the whole image size for autofocus parameters. Enter values: AOI width/height/left (coordinate) and top (coordinate). Allowed steps are shown in the fields X-Unit/Y-Unit. To highlight the AOI in the image, activate Show AOI check box.</td>
</tr>
<tr>
<td>Auto shutter range</td>
<td>Choose standard (Std.) or extended (Extd.) auto shutter range. Change lower and upper limit to restrict the auto shutter to operate between these limits and not the whole range. Useful for applications where a too long shutter time would cause e.g. motion blurring in the image.</td>
</tr>
<tr>
<td>Auto gain range</td>
<td>Change lower and upper limit. Change lower and upper limit to restrict the auto gain to operate between these limits and not the whole range. Useful for applications where a too high gain would cause noise in the image.</td>
</tr>
</tbody>
</table>

Table 10: SmartView Edit settings: Ctrl 2 tab
**Ctrl3 tab descriptions (only color progressive)**

**Ctrl3** tab exists in two variants:
- Description for color progressive cameras see below
- Description for color interlaced see Chapter **Ctrl3 tab descriptions (only color interlaced)** on page 45

**Progressive cameras**

<table>
<thead>
<tr>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extra features during debayering</td>
<td>These two features (hue/saturation) are only available if camera transmitting RAW image and SmartView doing the debayering process, using one of the following algorithms:</td>
</tr>
<tr>
<td></td>
<td>- 2x2 YUV422</td>
</tr>
<tr>
<td></td>
<td>- 2x2 LCAA</td>
</tr>
<tr>
<td></td>
<td>- 2x2 LCAA+V</td>
</tr>
<tr>
<td></td>
<td>It effectively changes both hue and saturation during debayering on the PC.</td>
</tr>
<tr>
<td></td>
<td>See Chapter <strong>Additional adjustment of hue and saturation</strong> on page 65.</td>
</tr>
<tr>
<td></td>
<td>These features are SmartView features, but not camera features.</td>
</tr>
<tr>
<td>Hue</td>
<td>Adjust <strong>Hue</strong> during debayering on the PC manually. (values in degrees)</td>
</tr>
<tr>
<td></td>
<td>- Hue on this tab is a SmartView feature, but not a camera feature.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Adjust <strong>Saturation</strong> during debayering on the PC manually. (values in percent)</td>
</tr>
<tr>
<td></td>
<td>- Saturation on this tab is a SmartView feature, but not a camera feature.</td>
</tr>
</tbody>
</table>

Table 11: SmartView Edit settings: **Ctrl 3** tab (progressive cameras)
**Ctrl3 tab descriptions (only color interlaced)**

Ctrl3 tab exists in two variants:
- Description for color progressive cameras see Chapter Ctrl3 tab descriptions (only color progressive) on page 44
- Description for color interlaced see below

### Interlaced cameras

<table>
<thead>
<tr>
<th>Description</th>
<th>Advanced white balance</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For the interlaced color Guppys (Guppy F-038/038 NIR/044/044 NIR) using complementary color filters (Cy, Mg, Gr, Ye) there is a non-standard (non-IIDC) register for white balance (0xF10080C4 and 0xF10080C8). This register is similar to the standard white balance CSR: here each of the four colors can be controlled independently. See the four sliders in this table.</strong></td>
<td>For the interlaced color Guppys (Guppy F-038/038 NIR/044/044 NIR) using complementary color filters (Cy, Mg, Gr, Ye) there is a non-standard (non-IIDC) register for white balance (0xF10080C4 and 0xF10080C8). This register is similar to the standard white balance CSR: here each of the four colors can be controlled independently. See the four sliders in this table.</td>
</tr>
<tr>
<td><strong>Note: One-push white balance is not available.</strong></td>
<td><strong>Note: One-push white balance is not available.</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Check box / combo box / list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Green/Cyan</strong></td>
<td>Adjust advanced white balance manually for</td>
</tr>
<tr>
<td></td>
<td>• Green in Format_7 Mode_1 or</td>
</tr>
<tr>
<td></td>
<td>• Green/Cyan in Format_7 Mode_0</td>
</tr>
<tr>
<td><strong>Magenta/Yellow</strong></td>
<td>Adjust advanced white balance manually for</td>
</tr>
<tr>
<td></td>
<td>• Magenta in Format_7 Mode_1 or</td>
</tr>
<tr>
<td></td>
<td>• Magenta/Yellow in Format_7 Mode_0</td>
</tr>
<tr>
<td><strong>Cyan/Magenta</strong></td>
<td>Adjust advanced white balance manually for</td>
</tr>
<tr>
<td></td>
<td>• Cyan in Format_7 Mode_1 or</td>
</tr>
<tr>
<td></td>
<td>• Cyan/Magenta in Format_7 Mode_0</td>
</tr>
<tr>
<td><strong>Yellow/Green</strong></td>
<td>Adjust advanced white balance manually for</td>
</tr>
<tr>
<td></td>
<td>• Yellow in Format_7 Mode_1 or</td>
</tr>
<tr>
<td></td>
<td>• Yellow/Green in Format_7 Mode_0</td>
</tr>
</tbody>
</table>

Table 12: SmartView Edit settings: **Ctrl 3 tab (interlaced cameras)**
## Trig/IO tab descriptions

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Trigger</strong></td>
<td><strong>Mode</strong></td>
<td>The following trigger modes may be available (depending on camera model: internal/edge mode/level mode can be: Ext=external trigger SW=software trigger):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Internal (continuous output)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Edge mode(0)-Ext</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Level mode(1)-Ext</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Progr. mode(15)-Ext aka Trigger_Mode_15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Edge mode(0)-SW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Level mode(1)-SW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Progr. mode(15)-SW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Beside Internal the other modes require a signal at the trigger pin of the I/O (HIROSE) connector to get an image.</td>
</tr>
<tr>
<td><strong>Polarity</strong></td>
<td><strong>Mode</strong></td>
<td>Polarity of trigger signal (depending on camera model and mode)  Adam mode(0) and Progr. mode(15):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Falling</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rising</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Level mode(1):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Low act.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• High act.</td>
</tr>
<tr>
<td><strong>Multishot counter</strong></td>
<td><strong>Mode</strong></td>
<td>Choose number of images the camera will take.</td>
</tr>
<tr>
<td><strong>Trigger delay</strong></td>
<td><strong>On</strong></td>
<td>Delay between trigger signal and image acquisition On/off only available, when Edge mode(0)</td>
</tr>
<tr>
<td></td>
<td><strong>μs</strong></td>
<td>Delay time in μs for exposure start after trigger signal</td>
</tr>
</tbody>
</table>

Table 13: SmartView Edit settings: **Trig/IO tab**
### Table 13: SmartView Edit settings: Trig/IO tab

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration enable delay</td>
<td>☐ On</td>
<td>Delay between integration (shutter) and output signal integration enable (IntEna)</td>
</tr>
<tr>
<td></td>
<td>☀ µs</td>
<td>Time in µs for delay of integration enable event (IntEna)</td>
</tr>
<tr>
<td>SW Trigger</td>
<td>Trigger button</td>
<td>With edge mode: click on Trigger to set exactly one trigger signal. With level/progr. mode: Click Trigger to start the trigger. Click Stop Trigger to stop the trigger.</td>
</tr>
</tbody>
</table>
### Input/Output pins

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box / list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input/Output pins</td>
<td>List of all inputs and outputs of a camera.</td>
<td>The number of inputs and outputs depend on the camera model.</td>
</tr>
<tr>
<td><strong>Mode column</strong></td>
<td></td>
<td>For each pin you can choose one of the following modes: Input ⇒ (Off/Trigger) Output ⇒ (Off/Direct/IntegrationEnable/FrameValid/Busy/FollowInp/PulseWidthMod/WaitingForTrigger). Query the camera manual for details on the signals.</td>
</tr>
<tr>
<td><strong>Invert column</strong></td>
<td></td>
<td>This is the polarity bit. The former Polarity column for the input/output pins is now called Invert to clarify the use of this bit. A polarity of low in former SmartView versions is now read as Invert:No, meaning the same.</td>
</tr>
<tr>
<td><strong>State column</strong></td>
<td></td>
<td>Lists the status of the input/output pin (Low or High).</td>
</tr>
<tr>
<td><strong>Period column</strong></td>
<td></td>
<td>Only available for cameras with pulse width modulation (see Technical Manual).</td>
</tr>
<tr>
<td><strong>Width column</strong></td>
<td></td>
<td>Only available for cameras with pulse width modulation (see Technical Manual).</td>
</tr>
<tr>
<td><strong>Debounce column</strong></td>
<td></td>
<td>Enter debounce time in 500 ns increments. Example: 3 is equivalent to 3x500ns=1.5µs</td>
</tr>
<tr>
<td><strong>Poll the I/O state continually</strong></td>
<td></td>
<td>Activate check box to update the state of pins every 200 ms.</td>
</tr>
<tr>
<td><strong>Software trigger</strong></td>
<td><img src="Trigger.png" alt="Trigger" /> ![Stop Trigger](Stop Trigger.png)</td>
<td>To start software trigger click Trigger button. It is self cleared, when using edge mode; must be set back manually (click Stop trigger button), when using level mode.</td>
</tr>
</tbody>
</table>

Table 13: SmartView Edit settings: **Trig/IO** tab
## LUT/Shdg. tab descriptions

**Note**
- For a detailed description on **LUT** see Chapter Working with LUTs on page 84.
- For a detailed description on **shading** see Chapter Working with shading on page 77.

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lookup tables</td>
<td>□ LUT operation on</td>
<td>Camera-internal LUT on/off</td>
</tr>
<tr>
<td>LUT #</td>
<td></td>
<td>Choose camera-internal LUT (both: for uploading and selecting). There is one set for data per LUT number. Therefore LUT data combo box, Upload button and contents of LUT editor may change if you select a new LUT number.</td>
</tr>
<tr>
<td>LUT data</td>
<td></td>
<td>Choose built-in LUT: • data from the file below • a table for gamma = 0.7 • a table for gamma = 0.45 • a table for inversion • a table for identity The following two entries are only for display: • &lt;empty&gt; means: SmartView has not written any data into the camera yet. Therefore SmartView does not know what LUT data is currently used by the camera (LUT cannot be read from camera). • &lt;modified&gt; is displayed, whenever LUT data was modified by the LUT editor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Opens the LUT editor with built-in viewer and displays the uploaded LUT. For a detailed description see Chapter Using LUT editor with built-in viewer: Overview on page 90</td>
</tr>
</tbody>
</table>

Table 14: SmartView Edit settings: LUT/Shdg. tab
### Table 14: SmartView Edit settings: LUT/Shdg. tab

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lookup tables (cont.)</td>
<td>Upload</td>
<td>Uploads the selected data into the camera. (Note: The button is colored to indicate that the LUT data in SmartView differs from the data in the camera.)</td>
</tr>
</tbody>
</table>
| LUT file              | ...                                  | Only available when choosing **data from the file below**  
Choose directory and file for upload process.  

Import data from column starting at | | Only available when choosing **data from the file below**  
Choose column where LUT is stored and choose row number where LUT starts.  

<table>
<thead>
<tr>
<th>Shading correction</th>
<th>Shading correction on</th>
<th>Shading correction on/off</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Show shading data as image</td>
<td>Select shading image as camera output.</td>
</tr>
<tr>
<td></td>
<td>Build shading data from</td>
<td>Builds camera-internal shading image. Choose number of images to be averaged (in order to reduce noise...) for building the shading image.</td>
</tr>
<tr>
<td></td>
<td>Flash</td>
<td>Use option <strong>Flash</strong> to save/load shading image in user sets (inside camera).</td>
</tr>
<tr>
<td></td>
<td>Load from flash</td>
<td>Loads a shading image stored in user sets (inside camera).</td>
</tr>
<tr>
<td></td>
<td>Clear flash</td>
<td>Clears shading image stored in user sets (inside camera).</td>
</tr>
<tr>
<td></td>
<td>File</td>
<td>Use option <strong>File</strong> to save/load shading image to/from an external file.</td>
</tr>
<tr>
<td></td>
<td>Upload from file</td>
<td>Uploads an external stored shading image.</td>
</tr>
<tr>
<td></td>
<td>Shading data file</td>
<td>Choose different external files for uploading/saving. The combo box lists recently used shading files (for upload/save operations).</td>
</tr>
</tbody>
</table>
## Adv 1 tab descriptions

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extended shutter</td>
<td>µs</td>
<td><strong>Absolute time of exposure</strong> in µs. Settings override the standard shutter settings (and vice versa). Max. settings depend on camera model.</td>
</tr>
<tr>
<td>Std. shutter timebase</td>
<td>Timebase</td>
<td>AVT timebase controls the base factor for the standard shutter register. Camera needs to be stopped for changes in this register. Shutter value (Slider Shutter on page 41) is multiplied with time base.</td>
</tr>
<tr>
<td>Test images</td>
<td>Active image</td>
<td>Choose one of the camera-internal images as image source. Depending on the camera model you can choose between different test images. See AVT Technical Manuals.</td>
</tr>
<tr>
<td>Mirror image</td>
<td>[ ] Horizontal [ ] Vertical</td>
<td>Depending on the camera model you can flip the image horizontally/vertically. This is done in hardware in the camera.</td>
</tr>
</tbody>
</table>

Table 15: SmartView Edit settings: Adv 1 tab
### Table 15: SmartView Edit settings: **Adv 1 tab**

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deferred transport</td>
<td>☑ Hold images</td>
<td>Deferred image transport is available for Stingray, Pike, Marlin, Oscar cameras. Activate <strong>Hold images</strong> to stop image transfer to the viewer (SmartView) and store the image in FIFO.</td>
</tr>
<tr>
<td></td>
<td>☑ Fast capture</td>
<td>Activates <strong>FastCapture</strong> mode of AVT deferred image transport. The sensor is read out at its maximum speed. Alternatively the sensor is read out at a speed according to the transmission settings.</td>
</tr>
<tr>
<td># of images to send</td>
<td></td>
<td>Choose number of images which will be sent when clicking on <strong>Send images</strong>. Set to 0 to send all images in FIFO.</td>
</tr>
<tr>
<td>FIFO size</td>
<td></td>
<td>Displays size of internal image FIFO in terms of frames.</td>
</tr>
<tr>
<td>FIFO used</td>
<td></td>
<td>Lists number of images currently held in FIFO.</td>
</tr>
<tr>
<td></td>
<td><strong>Send images</strong></td>
<td>Read(s) image(s) from FIFO and send images over bus to SmartView.</td>
</tr>
<tr>
<td>□ Lock image capture</td>
<td></td>
<td>Prevents AVT SmartView from sending ISO-enable/one-shot command to the camera when using the black arrows on bottom of window. With <strong>Lock image capture</strong> activated the above buttons prepare SmartView viewer window without starting the camera (ISO enable).</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Lock image capture" /></td>
<td>With <strong>Lock image capture</strong> on, clicking on red arrows (free-run, one-shot) starts camera and images are captured into FIFO. With <strong>Lock image capture</strong> on, clicking on red arrows (free-run, one-shot) starts camera and images are captured into FIFO.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Free-run, one-shot" /></td>
<td>Capture images into the FIFO using free-run mode.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="One-shot" /></td>
<td>Capture images into the FIFO using one-shot mode.</td>
</tr>
<tr>
<td>Version information</td>
<td>Microcontroller/Order Number/ FPGA/Serial number</td>
<td>Lists the version numbers and IDs of firmware (microcontroller/FPGA), the order number of the camera and the serial number of the camera.</td>
</tr>
</tbody>
</table>

AVT SmartView for FirePackage V2.3.1
### Adv 2 tab descriptions

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial port (IIDC-1.31)</td>
<td>Bitrate</td>
<td>Choose <strong>bit rate for camera’s RS232 serial port.</strong> It can be used to send and receive data to and from an external device, connected to the camera.</td>
</tr>
<tr>
<td></td>
<td>Char length</td>
<td>Choose <strong>character length for serial input/output:</strong></td>
</tr>
<tr>
<td></td>
<td>Parity</td>
<td>Choose <strong>parity for serial input/output</strong></td>
</tr>
<tr>
<td></td>
<td>Stop bits</td>
<td>Choose <strong>number of stop bits for serial input/output</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1 stop bit</td>
</tr>
<tr>
<td></td>
<td>Serial port off</td>
<td>Disable serial input/output of camera</td>
</tr>
<tr>
<td></td>
<td>Transmitter on</td>
<td>Enable only serial sending</td>
</tr>
<tr>
<td></td>
<td>Receiver on</td>
<td>Enable only serial receiving</td>
</tr>
<tr>
<td></td>
<td>Both on</td>
<td>Enable bidirectional serial input/output</td>
</tr>
<tr>
<td></td>
<td>Transmit</td>
<td>Enter text to be transmitted to camera.</td>
</tr>
<tr>
<td></td>
<td>Receive</td>
<td>Any data which is received by the camera via RS232 will be displayed here until the buffer is full.</td>
</tr>
</tbody>
</table>

Table 16: SmartView Edit settings: Adv 2 tab
<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure image signature (SIS) &amp; counters</td>
<td>☐ Enable</td>
<td>Only Marlin, Pike or Stingray CCD cameras: available with firmware V3.03 or newer. See Marlin, Pike or Stingray Technical Manual, Chapter Secure image signature (SIS). Activate check box for writing time stamp (a very precise clock), frame counter and trigger counter data directly into image (Pike: also additional SIS data). After activating check box these data are stamped at a selectable row position left in the image.</td>
</tr>
<tr>
<td>Row</td>
<td></td>
<td>Choose where these data are put into the image: Row 0: top of image Row 1,2,...: rows below top of image Row -1: bottom of image Row -2,-3,...: rows above bottom of image</td>
</tr>
<tr>
<td></td>
<td><img src="" alt="Show SIS.." /></td>
<td>Click to display SIS information (secure image signature)</td>
</tr>
<tr>
<td>User value</td>
<td></td>
<td>Only Pike: Enter a user value which will be written into the camera.</td>
</tr>
<tr>
<td>Frame Counter</td>
<td><img src="" alt="Reset" /></td>
<td>Frame counter and trigger counter can also be read out asynchronously from registers (i.e. not out of image). Activate Display check box for displaying frame/trigger counter numbers. Frame counter field displays number of images taken since clicking on <img src="" alt="Reset" />. Trigger counter field displays number of external trigger events since clicking on <img src="" alt="Reset" />.</td>
</tr>
<tr>
<td>Trigger Counter</td>
<td><img src="" alt="Reset" /></td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>☑</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>☐ Color correction</td>
<td>Depending on camera model: Activate check box for using built-in color correction matrix. For certain camera models the matrix coefficients can be modified using Adv3 tab. <strong>Note:</strong> It is not an intuitive procedure to change the coefficients of a 3 x 3 matrix in the RGB color domain!</td>
</tr>
</tbody>
</table>

Table 16: SmartView Edit settings: Adv 2 tab
<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
</table>
| Camera reset                    | Soft reset, Initialize               | Soft reset: camera feature
Click Soft reset for rebooting the internal logic in the camera (FPGA) and forcing the 1394 bus to reset.
Click Initialize for setting FPGA back to default values. No reset of the 1394 bus. |
| User sets (Memory channels)     |                                      | See Technical Manuals, Chapter User profiles. Used to store/recall custom settings in/from camera.                                        |
|                                 | Save                                 | Saves current settings in chosen user set (1..3).                                                                                           |
|                                 | Load                                 | Loads settings from chosen user set (1..3) without rebooting camera.                                                                      |
|                                 | Set as default                       | Starts the chosen user set (1..3) on next camera start automatically.                                                                      |
|                                 | Set No. [ ]                          | Choose desired user set number for save/load/set as default action.  
User Set No. 0 = factory setting (can not be changed)  
User Set No. 1..3 = save/load/set as default actions possible |

Table 16: SmartView Edit settings: Adv 2 tab
## Adv 3 tab descriptions

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box / list / slider</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Color correction** | Correction matrix                      | Only cameras with color correction and correction matrix feature implemented. See Pike/Stingray/Guppy PRO Technical Manual, Chapter Color correction. To change matrix elements first activate color correction check box on Adv 2 tab. Change value in each of the nine fields of correction matrix manually. Enter values between -1000 and +2000. 1000 means a factor of 1.0. If you want to get back factory settings, click Reset to default. The row sum is displayed: Pay attention to the following:  
- The sums of all rows should be equal to each other. If not, you get tinted images.  
- In order for white balance to work properly ensure that the row sum equals 1000.  
- Each row should sum up to 1000. If not, images are less or more colorful. |
| Smear reduction  | Enable                                 | Enables disables smear reduction (only Pike).                                                                                                                                                              |
| Software features| □ Disable LED functionality            | Only Stingray/Guppy PRO cameras. Activate check box to switch off LEDs. Note: During startup of the camera and if an error condition is present, the LEDs behave as usual.                                         |
| Number of digitization taps | | Choose number of digitization taps (only cameras with multi-tap sensors: e.g. Pike F-1100/1600) and click Apply. |

Table 17: SmartView Edit settings: Adv 3 tab
## Adv 4 tab descriptions (only Stingray)

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defect pixel correction</td>
<td>Defect pixel correction on</td>
<td>Enable/disable defect pixel correction. The first image is done by the camera itself. For detailed information see Stingray Technical Manual, Chapter Defect pixel correction.</td>
</tr>
<tr>
<td></td>
<td>Threshold</td>
<td>Via threshold you can define the defect pixels in an image.</td>
</tr>
<tr>
<td></td>
<td>Detect</td>
<td>Click Detect to detect the defect pixels. The number is shown above the Threshold slider.</td>
</tr>
<tr>
<td></td>
<td>Save data to flash</td>
<td>Saves data to the flash memory.</td>
</tr>
<tr>
<td></td>
<td>Load data from flash</td>
<td>Loads data from the flash memory.</td>
</tr>
<tr>
<td></td>
<td>View/Edit</td>
<td>Lets you edit defect pixels manually.</td>
</tr>
</tbody>
</table>

Table 18: SmartView Edit settings: Adv 4 tab

## Adv 4 tab descriptions (Defect pixel correction: only Pike)

For Pike F-1100/1600 and AVT SmartView 1.13 or greater you can edit the list of defect pixels directly in the camera (Adv 4 tab).

**Note** For a detailed description see PIKE Technical Manual V5.1.0 or greater, Chapter Defect pixel editor in SmartView.
**CMOS tab descriptions**

(only Guppy F-036, Martin F-131, Guppy F-503, Guppy PRO F-503)

**Note** To use this feature number of knee points must be greater 0.

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High dynamic range mode</td>
<td>(only Guppy F-036)</td>
<td>For Guppy F-036 see Guppy Technical Manual, Chapter HDR (high dynamic range) (Guppy F-036 only) To use this feature first change number of knee points to value greater 0. Then activate HDR mode on check box. Guppy F-036: In Knee points choose 1 or 2 and enter Voltage value in Voltage #1 (and Voltage #2).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage #1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage #2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Knee points</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 19: SmartView Edit settings: CMOS tab
### AVT SmartView for FirePackage

Table 19: SmartView Edit settings: **CMOS** tab

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High dynamic range mode (only Marlin F-131)</td>
<td>(only Marlin F-131) Knee points</td>
<td>For Marlin F-131 see Marlin Technical Manual, Chapter <strong>High dynamic range mode (Marlin F-131B/C only)</strong> To use this feature first change number of knee points to value greater than 0. Choose number of knee points: 1, 2 or 3.</td>
</tr>
<tr>
<td></td>
<td>HDR mode on</td>
<td>Then activate <strong>HDR mode on</strong> check box. <strong>Marlin F-131</strong>: Choose <strong>Easy mode</strong> or <strong>Expert mode</strong> by clicking on the radio button.</td>
</tr>
<tr>
<td></td>
<td>Display graph</td>
<td>For a graphical on-the-fly representation of the HDR mode activate <strong>Display graph</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>Easy mode</td>
<td>In <strong>Easy mode</strong> put slider in the desired position (the knee point values will be set automatically). An Easy mode value for the dynamic gain increase in dB will be shown (7.4 dB in our example). Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Control your setting in the graph. ☑ The <strong>Easy mode</strong> is a SmartView feature, but not a camera feature.</td>
</tr>
<tr>
<td></td>
<td>Expert mode</td>
<td>In <strong>Expert mode</strong> enter values for Add.time #1 (#2, #3) manually. Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shutter time and Total time are displayed. Control your settings in the graph.</td>
</tr>
</tbody>
</table>

![Example of 3 knee points](image_url)
### DSNU/Blemish pixel correction (only Martin F-131)

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSNU/Blemish pixel correction</td>
<td>☐ DSNU correction on</td>
<td>See Marlin Technical Manual, Chapter DSNU &amp; blemish correction. DSNU = Dark signal non-uniformity. Close the lens or the aperture so that no light hits the sensor for DSNU and blemish correction procedures. Activate check box to use DSNU.</td>
</tr>
<tr>
<td></td>
<td>☐ Blemish correction on</td>
<td>Activate check box to use blemish correction. This will identify and compensate for defective pixels by using intact neighbors.</td>
</tr>
<tr>
<td></td>
<td>☐ Show correction data image</td>
<td>Activate check box for displaying correction data as image.</td>
</tr>
<tr>
<td></td>
<td>![Build] Correction data using</td>
<td>Builds DSNU/blemish pixel correction image from the number of images you have chosen (possible numbers are 1, 2, 4, 8, 16).</td>
</tr>
<tr>
<td></td>
<td>![Save data to flash]</td>
<td>Saves the correction data into the correction data storage.</td>
</tr>
<tr>
<td></td>
<td>![Load data from flash]</td>
<td>Loads the factory settings into the correction data storage.</td>
</tr>
<tr>
<td></td>
<td>![Delete correction data]</td>
<td>Empties the correction data storage.</td>
</tr>
</tbody>
</table>

### Defect Pixel Correction (only Guppy F-503 and Guppy PRO F-503)

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box/ list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defect Pixel Correction</td>
<td>Defect pixel correction on</td>
<td>Enable/disable defect pixel correction. For detailed information on defect pixel correction see Guppy Technical Manual and Guppy PRO Technical Manual. The first image is initiated by SmartView itself.</td>
</tr>
<tr>
<td></td>
<td>Threshold</td>
<td>Via threshold you can define the defect pixels in an image.</td>
</tr>
<tr>
<td></td>
<td>Detect</td>
<td>Click Detect to detect the defect pixels. The number is shown above the Threshold slider.</td>
</tr>
<tr>
<td></td>
<td>Save data to flash</td>
<td>Saves data to the flash memory.</td>
</tr>
<tr>
<td></td>
<td>Load data from flash</td>
<td>Loads data from the flash memory.</td>
</tr>
<tr>
<td></td>
<td>View/Edit</td>
<td>Lets you edit defect pixels manually.</td>
</tr>
</tbody>
</table>

Table 19: SmartView Edit settings: CMOS tab
Shutter mode (only Guppy F-503)

- **Electronic rolling shutter**
- **Global reset release shutter**

Switch between these two shutter modes. SmartView shows automatically Format tab (frame rates and other features may be changed.) For detailed information on shutter modes see **Guppy Technical Manual**, Chapter Electronic rolling shutter (ERS) and global reset release shutter (GRR) (only Guppy F-503)

Table 19: SmartView Edit settings: **CMOS** tab

![Example of CMOS tab for Guppy F-503](image)

Figure 4: Example of CMOS tab for Guppy F-503
Direct register access window

**Note** The height of this window can be adjusted, but not the width (although double arrows are shown).

**Definition** Direct access window is a tool to write data into registers directly and read out data from registers directly (in hex code).

<table>
<thead>
<tr>
<th>Check box / combo box / list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register</td>
<td>Lists all accessible registers by the clear names.</td>
</tr>
<tr>
<td>Address</td>
<td>The address of the chosen register is displayed immediately. Alternatively you can enter an address in hex code manually.</td>
</tr>
<tr>
<td>Data</td>
<td>Lists the data that is read from or written to the chosen register.</td>
</tr>
<tr>
<td>Read</td>
<td>Reads data from chosen register.</td>
</tr>
<tr>
<td>Write</td>
<td>Writes data in chosen register.</td>
</tr>
<tr>
<td>List # column</td>
<td>Counts the number of read/write actions.</td>
</tr>
<tr>
<td>rw column</td>
<td>Displays type of action: rd=read wr=write</td>
</tr>
<tr>
<td>Address column</td>
<td>Displays the address of read/write action in hex code.</td>
</tr>
<tr>
<td>Value column</td>
<td>Displays the value of read/write action in hex code.</td>
</tr>
</tbody>
</table>

Table 20: Smart View Direct access window: descriptions
Operating AVT cameras with SmartView

In this chapter you will find descriptions how to operate AVT cameras with the SmartView software. The most important camera functions are explained and you learn how to use these functions effectively with SmartView.

Debayering algorithms

These algorithms are SmartView features, but not camera features.

Conditions

- Only PC debayering (via SmartView)
- Only color cameras
- Works only in RAW8/RAW12/RAW16/Mono8 mode (depending on specific camera type); in RAW12/RAW16 mode only 2x2 algorithm available

Where to find

SmartView:  Edit settings  Format tab

**Only RAW8 formats**: additional adjustment of hue and saturation possible (using methods YUV422/LCAA/LCAA+V):

SmartView:  Edit settings  Ctrl3 tab (color progressive)

Figure 5: Debayering: Example of choosing type (Pike F-210C)

Figure 6: Hue and saturation: Example of additional adjustment (Guppy F-046C)
### Description

The following debayering algorithms are available (depending on specific camera type):

<table>
<thead>
<tr>
<th>Debayering algorithm</th>
<th>Choose type</th>
<th>Description</th>
<th>Advantages (+) and disadvantages (-)</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td>none</td>
<td>No debayering</td>
<td></td>
</tr>
<tr>
<td>2x2</td>
<td>2x2</td>
<td>Debayering is done on a 2x2 pixel basis</td>
<td>+ fastest (lowest CPU consumption) algorithm  - color fringe</td>
</tr>
<tr>
<td>2x2 mono</td>
<td>2x2 mono</td>
<td>Showing only mono image (luminance Y only) of 2x2 debayering</td>
<td>+ no color fringe (b/w image) - no color information</td>
</tr>
<tr>
<td>3x3</td>
<td>3x3</td>
<td>Debayering is done on a 3x3 pixel basis</td>
<td>+ less color fringe - less resolution - more CPU consumption</td>
</tr>
<tr>
<td>2x2</td>
<td>2x2 YUV422</td>
<td>Same algorithm as in AVT Marlin cameras (produces the same color output as Marlin in YUV422 mode). Color low-pass filtering with two horizontally neighboring pixels</td>
<td>+ faster algorithm compared to LCAA an LCAA+V - more horizontal color fringe than LCAA</td>
</tr>
<tr>
<td>2x2 LCAA</td>
<td>LCAA</td>
<td>LCAA = local color anti-aliasing Color low-pass filtering with four horizontally neighboring pixels</td>
<td>+ less horizontal color fringe - vertical color fringe</td>
</tr>
<tr>
<td>2x2 LCAA+V</td>
<td>LCAA+V</td>
<td>LCAA+V = local color anti-aliasing including vertical color smoothing Color low-pass filtering with a window of four horizontal and two vertical pixels</td>
<td>+ less horizontal and less vertical color fringe - slowest algorithm (highest CPU consumption)</td>
</tr>
</tbody>
</table>

Table 21: Description of debayering algorithms
The following BAYER patterns are available (depending on specific camera type):

<table>
<thead>
<tr>
<th>BAYER pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>auto. pattern</td>
<td>Default</td>
</tr>
<tr>
<td>RGGB</td>
<td>Use one of these patterns, if e.g. older SmartView versions use the wrong BAYER pattern.</td>
</tr>
<tr>
<td>GRBG</td>
<td>The first two letters are of 1st row of sensor, the last two letters are of 2nd row of sensor.</td>
</tr>
<tr>
<td>GBGR</td>
<td>R=red; G=green; B=blue</td>
</tr>
</tbody>
</table>

Table 22: Description of BAYER patterns

**Additional adjustment of hue and saturation**

- The following three types (YUV422, LCAA, LCAA+V) convert the transported RAW8 image to the YUV space.
- Here the (different) low-pass filtering of the color information (U and V values) is done to reduce color fringe at edges.
- Hue and saturation require intensive computations in YUV. If hue is 0 (no hue rotation) and saturation 100 (=100%) a more efficient back transformation is done.
- After that conversion to BGR space (Windows RGB) is done.
Advanced white balance (only Guppy color interlaced)

Conditions
- Only Guppy color interlaced cameras
- Only Format_7 Mode_0 and Mode_1

Where to find
Only Guppy (interlaced): adjustment of advanced white balance possible:
SmartView: Main window: Edit settings → Ctrl3 tab

Description
Guppy interlaced cameras use color sensors with complementary color filters (Green, Magenta, Cyan and Yellow). This sensor type is not covered by IIDC specification.

White balance requires a set of advanced registers to allow adjustments. In addition, there are two different Format_7 modes available:
- Mode_0 which effectively bins two rows and
- Mode_1 which is a frame integration mode
Thus Mode_0 and Mode_1 perform differently from the point of white balancing.

Format_7 Mode_0
In Format_7 Mode_0 (field integration, two lines are binned during sensor readout) advanced white balance is adjustable for each of the individual (binned-) pairs:
- Green/Cyan
- Magenta/Yellow
- Cyan/Magenta
- Yellow/Green

Figure 7: Advanced white balance: Example of adjustment G, Mg, Cy, Ye (Guppy F-038C NIR)
Format_7 Mode_1  In Format_7 Mode_1 (frame integration, two lines are binned in the software) advanced white balance is adjustable for each of the individual complementary colors:

- Green
- Magenta
- Cyan
- Yellow

There is no one-push function. Set the camera to auto to perform continuously white balance or switch auto off after the correct white balance is achieved.
Saving and streaming images

**Conditions**

- Hard disk or network drive with enough space
- Recording: Make one or more images. Then the recording options are available.
- Use deep images: only available with camera models having MONO12/16 (monochrome models) or RAW12/16 (color models)

**Where to find**

SmartView: Main window: File → Save
SmartView: Main window: File → Save as...
SmartView: Main window: File → Recording options
SmartView: Main window: File → Use deep images

![Figure 8: Where to find: Saving and streaming images](image)

**Description**

**Saving images to hard disk or network drive**

To save a single image to hard disk or network drive, use the File → Save as... command, choose directory and file name on your hard disk or network drive and choose the file format. The following file formats are available:

- BMP (*.BMP, *.DIB, *.RLE)
- JPEG (*.JPG, *.JPEG, *.JPE, *.JFIF)
- GIF (*.GIF)
- TIFF (*.TIF, *.TIFF)
- PNG (*.PNG)

When saving 16-bit images with Save as... command the ending *.raw is set automatically (although you can choose bmp, jpeg, gif, tiff, png only in the dialog) to the file name. The reason is the following: Windows operating sys-
tem is unable to display more than 8 bit. For display in SmartView the images are reduced to the upper 8 bit. Other image processing tools must be able to handle images with more than 8 bit.

For more information on deep images see Chapter Using deep images (only MONO12/16 mode or RAW12/16 color mode) on page 71.

<table>
<thead>
<tr>
<th>File format</th>
<th>Compressed/lossless</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP</td>
<td>Uncompressed, lossless</td>
<td>Best file format for all your applications. All image processing tools can open BMP files.</td>
</tr>
<tr>
<td>JPEG</td>
<td>Compressed, lossy</td>
<td>JPEG is a lossy format and file size is much smaller than bmp. Be aware that you may loose details in the image.</td>
</tr>
<tr>
<td>GIF</td>
<td>Uncompressed, lossless</td>
<td>Use GIF only if it is acceptable to store image only with 256 colors.</td>
</tr>
<tr>
<td>TIFF</td>
<td>Uncompressed, lossless</td>
<td>Tagged image file format, used in the printing industry. Use TIFF only if required; e.g. your image processing tool works only with TIFF format.</td>
</tr>
<tr>
<td>PNG</td>
<td>Compressed, lossless</td>
<td>PNG has compression and works lossless.</td>
</tr>
</tbody>
</table>

Table 23: Description of file formats

When the file exists, you can choose **File ➔ Save** or just click on the button to overwrite the file.
Streaming images: recording options

**Note**  
Precondition: First make one or more images, otherwise the **Recording options** menu is not available.

**Streaming is not** meant in the sense of a video file. You will have to use third party software to do offline conversion from the streamed images to a video file.

Alternatively **Streampix** software from www.norpix.com can be recommended for directly recording to a video file.

To continuously save images to hard disk or network drive in a streaming format, use the **File → Recording options** and configure your recording in the **Recording options** window (see Table 24: Recording options window: Descriptions on page 71).

![Recording options window](image)

**Note**  
Be aware that it is **not** guaranteed that each and every image from the camera is finally recorded to disk. SmartView is not optimized for unlimited recording.

You may improve the performance by setting the Frame buffers in **Format** tab of SmartView (see Frame buffers on page 39) to the maximum your system (and main memory) allows. Usually this amount of images can be recorded without loss of frames.
Operating AVT cameras with SmartView

To start recording click on .

Using deep images (only MONO12/16 mode or RAW12/16 color mode)

Definition

Deep images mean: in SmartView, 16 bits are used for storing and processing the image, if the depth of the sent images is larger than 8 bits.

All AVT models except for color Martin models are capable of sending either MONO16 or RAW16 images. Only certain Pike/Stingray/ Guppy / Guppy PRO models are also able to transport images in AVT specific Packed 12-Bit Modes called MONO12 and RAW12.

Depending on the camera the significant bits will be between 8 and 16 bits. The bit depth is MSB-aligned, that means a 10-bit image in the 16-bit format appears to have the same brightness as a 12-bit image, but the 12-bit image contains 2 more LSBs important for the finer grey-level details in an image.

<table>
<thead>
<tr>
<th>Section</th>
<th>Check box / combo box / list / slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name options</td>
<td>Current file name</td>
<td>After choosing number of digits click , choose directory, enter file name, file format and click on Save.</td>
</tr>
</tbody>
</table>
|                             | Number of digits ▲ 5                  | First choose number of digits for file name of all images in streaming format. Default: 5
Example:
recording_test00000.bmp
recording_test00001.bmp
... recording_test99999.bmp |
| Processing options          | Record every ▼ 1 . frame               | Choose if you want to record:
• every frame (1)
• every second (2)
• every third (3)
• ...
• every nth (n) |

Table 24: Recording options window: Descriptions

To start recording click on .

Using deep images (only MONO12/16 mode or RAW12/16 color mode)
Availability depending on camera model:

<table>
<thead>
<tr>
<th>Camera model</th>
<th>Deep images available?</th>
<th>Advantages (+) and disadvantages (-)</th>
</tr>
</thead>
<tbody>
<tr>
<td>All camera models which have the following formats: MONO12/RAW12 or MONO16/RAW16 support deep images.</td>
<td></td>
<td>Deep images have the following advantages (+) and disadvantages (-)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>+ images with enhanced dynamic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Windows operating system is unable to display more than 8 bit. For display in SmartView the images are reduced to the upper 8 bit. Other image processing tools must be able to handle images with more than 8 bit.</td>
</tr>
</tbody>
</table>

Table 25: Which cameras can use deep images?

For cameras with available deep images (MONO12, MONO16, RAW12 or RAW16) click on File → ✔️ Use deep images to use images with more than 8 bits.

Activating/deactivating deep images is stored automatically when closing the window.

Enhancements during deep image support are:

- Extended histogram: activating/deactivating deep images changes display of histogram instantaneously
- Tooltip pixel values are adjusted.
- Saving 16-bit images is possible: with Save as... command the ending *.raw is set automatically (although you can choose bmp, jpeg, gif, tiff, png only in the dialog) to the file name.
- Recording with 16-bit images is also possible.

Note: Saving images in deep image format, the file format is RAW, which means without header or trailer, as coming from the camera.

The higher byte comes first (the so called big endian format) and the assembled pixel value is MSB-aligned. That means: Unused lower bits are zero.

Example: a sequence of two 16-bit pixel „7F F0 FE 50“ of a 12-bit image refers to „07FF 0FE5“ (equals „2047 4069“ in decimal) values of the ADC.
Caution  Working with deep images, more processor power is needed: The viewer may be slower leading to dropped frames.

Loading and saving camera settings as XML files

Conditions
- To save and load camera settings to and from an XML (eXtensible Markup Language) configuration file, the MSXML parser must be installed on your system.
- Msxml3ger.msi: Installation file for the MSXML parser, version 3 service pack 4, German. For information or other languages see http://www.microsoft.com/downloads
- For quick read/write settings you first must create/save an xml file as standard xml file (Select Settings file... see below)

Where to find

Camera ➔ Settings ➔ Read settings from external file...
Camera ➔ Settings ➔ Write settings to external file...

Figure 10: Where to find: Loading and saving camera settings as XML files
Operating AVT cameras with SmartView

Camera → Settings → Select Settings file...
Camera → Settings → Quick Read Settings
Camera → Settings → Quick Write Settings

**Description**

Most of the configurations of cameras and features in SmartView can be saved on your computer in an XML file. Save your most used configurations in different XML files. This gives you the advantage to choose quickly between different settings.

For very quick loading/saving of one special setting you can use the **Select Settings file...** command and then the

- Quick Read Settings button or
- Quick Write Settings button

As an alternative save your camera settings as user settings in the camera.
Operating AVT cameras with SmartView

AVT SmartView for FirePackage V2.3.1

Working with the histogram function (SmartView feature only)

⇒ The histogram function is a SmartView feature, but not a camera feature.

Conditions
- Minimum size of histogram window is 256x128.
- Using deep images, histogram will show values up to 16 bit.

Where to find
View → Additional information → Histogram
(or use short key: Ctrl+Shift+H)

Figure 11: Where to find: Histogram

Description
A histogram shows the brightness distribution of an image (e.g. in an 8-bit image there will be 256 levels of brightness ranging from 0...255 with 0 as darkest and 255 as brightest value). The sum under the curve is equal to the total amount of pixels. Use the histogram for analyzing and optimizing brightness distributions.
- **Monochrome** cameras show one red curve in the histogram.
- **Color** cameras show three curves (red, green, blue) in the histogram
- **Interlaced** cameras show four curves (red, green, blue, yellow) in RAW mode and three curves with debayering (red, green, blue)

![Histogram Example](image)

**Figure 12: Example of histogram (Marlin F-201C)**

<table>
<thead>
<tr>
<th>Histogram element</th>
<th>Description</th>
</tr>
</thead>
</table>
| x axis            | Available values:  
8-bit image: 0...255  
12-bit image: 0...4095 (Oscar)  
14-bit image: 0...16383 (e.g. Pike Mono16)  
16-bit image: 0...65535 (e.g. Oscar with 16 images or Pike with 4 images; both in HSNR mode) |
| y axis            | Number of pixels with value at x axis |
| Max:              | Number of pixels at most frequent value (the corresponding x value is marked with an additional vertical black line: x-position of Max.) |

Table 26: Description of histogram
Operating AVT cameras with SmartView

Using histogram

The following 3 examples illustrate how to use the histogram function:

1. Experiment how the histogram changes on opening/closing aperture:
   - Open aperture: curve(s) move to right side
   - Closing aperture: curve(s) move to left side

2. Manual white balance (e.g. single-color/monochrome surface):
   - Consider green curve as reference
   - Adjust UB slider of white balance so that blue curve overlaps green curve
   - Adjust VR slider of white balance so that red curve overlaps green curve
   - Manual white balance done

3. To get a feeling for contrast of image:
   - If an image has little contrast, histogram will show Gaussian like curve(s) very likely.
   - If an image has very high contrast, histogram will show much more irregular curve(s).

Working with shading

Definition

Shading correction is also known as flat-field correction. It is effectively a multiplicative correction of each pixel. The cameras perform this task in hardware, thus not consuming any CPU power or delaying the image. In order to generate the correction factors per pixel, only an offline task in the camera does all the job.

Upon generation of the shading image in the camera, it can be uploaded to the host computer for non-volatile storage purposes.

With the Pike, you are now able to store your generated shading data in flash memory inside the camera, allowing you to calibrate your imaging setup once under controlled conditions and then just load the stored shading data with one command after camera startup without having to transfer data from the PC to the camera.

For this, you are now able to switch the external source/destination from “file” (like it was possible before) to “flash”, allowing you to store to flash, load from flash and to clear the flash instead of downloading and saving shading data to a file or uploading from a file.

<table>
<thead>
<tr>
<th>Histogram element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>127 (8-bit)</td>
<td>Middle of x-axis</td>
</tr>
<tr>
<td>255 (8-bit)</td>
<td>Maximum x value</td>
</tr>
</tbody>
</table>

Table 26: Description of histogram
Additional information

For additional information on the shading correction feature read the following chapters:

- Oscar Technical Manual, Chapter Shading correction
- Marlin Technical Manual, Chapter Shading correction
- Pike Technical Manual, Chapter Shading correction
- Stingray Technical Manual, Chapter Shading correction

Conditions

- Oscar cameras
- Marlin cameras
- Pike cameras
- Stingray cameras
- (Guppy cameras have no shading correction)
- (Guppy PRO cameras have no shading correction)

Where to find

SmartView: Edit settings → LUT/Shdg. tab

Figure 13: Shading correction: Example (Pike F-210C)
**Description**

**Usage**

Shading correction is used to compensate for non-homogeneities caused by lighting or optical characteristics within specified ranges.

To correct a frame, a multiplier from 1...2 is calculated for each pixel in 1/256 steps: this allows for shading to be compensated by up to 50%.

Besides generating shading data off-line and downloading it to the camera, the camera allows correction data to be generated automatically in the camera itself.

**Note**

For conditions and special features depending on the camera family/model see the **Technical Manuals** listed in Chapter Additional information on page 78.

There are two storing possibilities:
- After generating the shading image in the camera, it can be uploaded to the host computer for nonvolatile storage purposes.
- The shading image can be stored in the camera itself. (Pike only)

The following pictures describe the process of automatic generation of correction data (Pike F-032C). Surface plots and histograms were created using the **ImageJ** program.
On the left you see the source image with non-uniform illumination.
The surface plot on the right clearly shows a gradient of the brightness
(0: brightest $\rightarrow$ 255: darkest pixels).
The histogram shows a wide band of gray values.

By defocusing the lens, high-frequency image data is removed from the
source image, therefore it’s not included in the shading image.

**How to prepare for shading image**

Shading correction compensates for non-homogeneities by giving all pixels
the same gray value as the brightest pixel. This means that only the back-
ground must be visible and the brightest pixel has a gray value of less than
255 when automatic generation of shading data is started.

It may be necessary to use a neutral white reference, e.g. a piece of paper,
instead of the real image.

To generate a correction image do the following:
Operating AVT cameras with SmartView

1. In SmartView main window click **Edit settings → LUT/Shdg.** tab
2. In the **Shading correction** section activate **Shading correction on** check box.
3. Activate **Show shading data as image** check box.
4. Choose the number of images to use for building the shading image (shading data). The recommended number of images for shading correction is listed in the table below.

<table>
<thead>
<tr>
<th>Camera type</th>
<th>Recommended number of images for shading correction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oscar</td>
<td>4, 8, 16</td>
</tr>
<tr>
<td>Marlin</td>
<td>4, 8, 16</td>
</tr>
<tr>
<td>Pike</td>
<td>2, 4, 8, 16, 32, 64, 128, 256</td>
</tr>
</tbody>
</table>

Table 27: Recommended number of images for shading data

5. Click on **Build**.

   The automatic generation of shading data is started. The camera pulls in the number of images which were set in the combo box. An arithmetic mean value is calculated from them (to reduce noise).

   After this, a search is made for the brightest pixel in the mean value frame. The brightest pixel(s) remain unchanged. A factor is then calculated for each pixel to be multiplied by, giving it the gray value of the brightest pixel.

   All of these multipliers are saved in a **shading reference image**. The time required for this process depends on the number of frames to be calculated and on the resolution of the image.

**Note**

For conditions and special features depending on the camera family/model see the Technical Manuals listed in Chapter Additional information on page 78.

**How to load a shading image out of the camera**

Two saving mechanisms are possible:

- Saving shading reference image to flash (currently only Pike family)
- Saving shading reference image to file (all camera models with shading correction)
- Shading images can also be generated or modified with image processing software. You can use this mechanism to overlay symbols or generate a cross hair in the image by simply generating a “synthetic shading image” with the symbol or the cross hair.
6. Focus the lens again.

The image below will be seen, but now with a considerably more uniform gradient.

Table 28: Saving shading reference image to flash or data file

<table>
<thead>
<tr>
<th>For saving to flash ...</th>
<th>For saving to file ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose <strong>Flash</strong>.</td>
<td>Choose <strong>File</strong>.</td>
</tr>
<tr>
<td>Click <strong>Save to flash</strong></td>
<td>Click <strong>Download &amp; save as file</strong></td>
</tr>
<tr>
<td></td>
<td>Click <strong>...</strong>, choose directory and enter file name.</td>
</tr>
</tbody>
</table>

The shading reference file is saved...

| internal into flash memory | in an external file |

Figure 15: Example of shaded image

- On the left you see the image after shading correction.

Count: 307200  Min: 139
Mean: 157.039  Max: 162
StdDev: 2.629  Mode: 158 (84449)
• The surface plot on the right clearly shows nearly no more gradient of the brightness (0: brightest → 255: darkest pixels). The remaining gradient is related to the fact that the source image is lower than 50% on the right hand side.
• The histogram shows a peak with very few different gray values.

How to load a shading image into the camera

To load a generated correction image back into the camera do the following:
1. In SmartView main window click Edit settings → LUT/Shdg. tab.

<table>
<thead>
<tr>
<th>For loading from flash ... (inside camera)</th>
<th>For loading from file ... (outside camera)</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the Shading correction section choose ...</td>
<td></td>
</tr>
<tr>
<td>• Choose Flash.</td>
<td>• Choose File.</td>
</tr>
<tr>
<td>• Click Load from flash</td>
<td>• Click Upload from file</td>
</tr>
<tr>
<td></td>
<td>• Click ... , choose directory and enter file name.</td>
</tr>
</tbody>
</table>

The shading reference file is uploaded...

| from flash memory inside camera          | from external file outside camera       |

Table 29: Saving shading reference image to flash or data file
Working with LUTs

**Definition**
In image processing, look-up tables are often called LUTs, and they map index numbers to output values.

**Conditions**
- All AVT cameras have LUT feature.

**Where to find**
SmartView: Main window: Edit settings → LUT/Shdg. tab

![Configure look-up tables (LUT)](image)

Figure 16: Look-up tables (LUT): Example (Pike F-210C)
Operating AVT cameras with SmartView

Description

How many? Depending on the model AVT cameras provide from 1 up to 63 user-defined look-up tables (LUT).

<table>
<thead>
<tr>
<th>Camera type</th>
<th>... has how many LUTs?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stingray</td>
<td>1</td>
<td>The LUT # starts always with 0.</td>
</tr>
<tr>
<td>Pike</td>
<td>16 (# 0-15)</td>
<td>Camera types having only one LUT: the LUT # cannot be changed.</td>
</tr>
<tr>
<td>Guppy PRO</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Guppy</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Marlin</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Oscar</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Table 30: Number of LUTs depending on camera type

Usage

The use of one LUT allows any function (in the form Output = F(Input)) to be stored in the camera’s RAM and to be applied on the individual pixels of an image at run-time.

The address lines of the RAM are connected to the incoming digital data, these in turn point to the values of functions which are calculated offline, e.g. with a spreadsheet program.

This function needs to be loaded into the camera’s RAM before use.

Example

One example of using an LUT is the gamma LUT: see Chapter Using SmartView’s built-in LUTs on page 87.

Gamma LUT

The gamma LUT is known as compensation for the nonlinear brightness response of many displays e.g. CRT monitors. The look-up table converts the incoming bits from the digitizer to outgoing bits (for values see following table).

<table>
<thead>
<tr>
<th>Camera type</th>
<th>incoming ... bits</th>
<th>outgoing ... bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stingray</td>
<td>14</td>
<td>the most significant 12 bit of the 14 bit are used and further down converted to 10 bit</td>
</tr>
<tr>
<td>Pike</td>
<td>14</td>
<td>up to 14</td>
</tr>
<tr>
<td>Guppy PRO</td>
<td>14</td>
<td>the most significant 12 bit of the 14 bit are used and further down converted to 10 bit</td>
</tr>
<tr>
<td>Guppy</td>
<td>10</td>
<td>8</td>
</tr>
</tbody>
</table>

Table 31: Gamma LUT: incoming/outgoing bits
Using AVT’s spreadsheet LUTs (camera family dependent)

For each camera family AVT delivers specialized spreadsheets with a variety of LUTs which you can use immediately.

To use AVT’s spreadsheet LUTs do the following:

1. Choose data from the file below in the LUT data combo box, click and choose directory and LUT file you like to use. (Example: LUT_Pike_Gamma_040_150.csv. Description: see table below. Or use your own *.csv file.).
   - All functions in the delivered AVT ...Gamma_040_150.csv file start in row 2 (first row = header row). The first look-up table with gamma=0.4 is Col B. The steps between two columns is 0.05. So gamma=0.9 for example is Col L.
   - All functions in the delivered AVT ...Contrast.csv file start in row 2 (first row = header row). The first contrast table with 0.25 is Col B and the last contrast table with 4 is Col Q.

2. From the two combo boxes choose column (example: Col B) and row (example: Row 2) for the function to be applied.

3. Click . (Note: The button is colored to indicate that the LUT data in SmartView differs from the data in the camera.)
   - The chosen LUT is uploaded to the camera. The button changes to , to indicate that the LUT data in SmartView is the same as in the camera.

4. To get a feeling how the LUT looks like click .
   - The LUT editor opens and a graph of the chosen LUT is displayed.

<table>
<thead>
<tr>
<th>Camera type</th>
<th>incoming ... bits</th>
<th>outgoing ... bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marlin</td>
<td>10</td>
<td>8</td>
</tr>
<tr>
<td>Oscar</td>
<td>12</td>
<td>8</td>
</tr>
</tbody>
</table>

Table 31: Gamma LUT: incoming/outgoing bits

Caution

If using the LUT editor (Chapter Using LUT editor with built-in viewer: Overview on page 90) only the chosen column is displayed and on saving the modified LUT you loose all other columns.

Therefore: If you want to work with the delivered AVT ...Gamma_040_150.csv file and the delivered AVT ...Contrast.csv file:

Never use the Save button in the LUT editor, unless using a new file name.
Using SmartView's built-in LUTs

SmartView has the following LUTs for using without any (external) *.csv files:

See Table 33: Description of LUTs available in SmartView on page 88.

To use them do the following:

1. Choose any of the built-in LUTs (a table for...) in the LUT data combo box and choose a LUT # where this LUT will be written to.

2. Click **Upload**.

   The chosen LUT is uploaded to the camera. The button changes to **Upload**, to indicate that the LUT data in SmartView is the same as in the camera.

3. To get a feeling how the LUT looks like click **Edk**.

   The **LUT editor** opens and a graph of the chosen LUT is displayed.

   In the following table you find example graphs (Pike F-210C) for SmartView's built-in LUTs.

<table>
<thead>
<tr>
<th>Camera type</th>
<th>... is delivered with LUT files</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stingray</td>
<td>LUT_Stingray_Gamma_040_150.csv, LUT_Stingray_Contrast.csv</td>
<td>...Gamma_40_150.csv provides gamma tables (gamma functions with gamma 0.4 up to 1.5, using steps of 0.05)</td>
</tr>
<tr>
<td>Pike</td>
<td>LUT_Pike_Gamma_040_150.csv, LUT_Pike_Contrast.csv</td>
<td>...Contrast.csv provides LUTs for increasing or decreasing the contrast for an image. Each of them has 16 tables with contrast values ranging from factor 0.25 to factor 4. A factor of 4 means that the gradient in the middle of the LUT is steeper by a factor of 4.</td>
</tr>
<tr>
<td>Guppy PRO</td>
<td>LUT_Guppy_PRO_Gamma_040_150.csv, LUT_Guppy_PRO_Contrast.csv</td>
<td></td>
</tr>
<tr>
<td>Guppy</td>
<td>LUT_Guppy_Gamma_040_150.csv, LUT_Guppy_Contrast.csv</td>
<td></td>
</tr>
<tr>
<td>Marlin</td>
<td>LUT_Marlin_Gamma_040_150.csv, LUT_Marlin_Contrast.csv</td>
<td></td>
</tr>
<tr>
<td>Oscar</td>
<td>LUT_Oscar_Gamma_040_150.csv, LUT_Oscar_Contrast.csv</td>
<td></td>
</tr>
</tbody>
</table>

Table 32: Description of LUTs depending on camera type
<table>
<thead>
<tr>
<th>Name of LUT (SmartView)</th>
<th>Description</th>
<th>Display LUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>a table for gamma = 0.7</td>
<td>Table with the following function: Output=(Input)^0.7</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td>a table for gamma = 0.45</td>
<td>Table with the following function: Output=(Input)^0.45</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
</tbody>
</table>

Table 33: Description of LUTs available in SmartView
<table>
<thead>
<tr>
<th>Name of LUT (SmartView)</th>
<th>Description</th>
<th>Display LUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>a table for inversion</td>
<td>Table with the following function: The identity graph is mirrored at the middle axis.</td>
<td>![Image of Display LUT]</td>
</tr>
<tr>
<td>a table for identity</td>
<td>Table with the following function: Output=Input</td>
<td>![Image of Display LUT]</td>
</tr>
</tbody>
</table>

Table 33: Description of LUTs available in SmartView
Using LUT editor with built-in viewer: Overview

Where to find
Main window: Edit settings → LUT/Shdg. tab → Edit

Note
• Requirements for display of histogram and Preview button:
  – 12-bit or 16-bit mode (Raw or Mono)
  – one acquired image in one of these modes
  – stop image acquisition before opening the LUT editor
• By closing the LUT editor, the original image is restored.
The following screenshot shows the main elements of the LUT editor:

Figure 17: LUT editor with built-in viewer
<table>
<thead>
<tr>
<th>Window element</th>
<th>Description</th>
<th>Examples, controls, buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph window</td>
<td>• shows LUT data as graph</td>
<td>Example of dotted lines and</td>
</tr>
<tr>
<td></td>
<td>• With mouse cursor inside graph window, dotted lines in X and Y axis show</td>
<td>exact x and y position:</td>
</tr>
<tr>
<td></td>
<td>position of associated LUT data value. Exact values are displayed in the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>lower left corner of graph window. x=....</td>
<td></td>
</tr>
<tr>
<td></td>
<td>y=....</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example of dotted lines and exact x and y position:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>x=1046</td>
<td></td>
</tr>
<tr>
<td></td>
<td>y=2658</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example of graph window</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pike F-032C</td>
<td></td>
</tr>
<tr>
<td>Color bar (below graph: horizontal</td>
<td>Shows each output value as a grey color</td>
<td></td>
</tr>
<tr>
<td>and at right side graph: vertical)</td>
<td>• 0 is shown as black</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• maximum value that the current camera supports is shown as white</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example of horizontal color bar:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Minimum value 8192</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maximum value 16384</td>
<td></td>
</tr>
</tbody>
</table>

Table 34: LUT editor: window elements
<table>
<thead>
<tr>
<th>Window element</th>
<th>Description</th>
<th>Examples, controls, buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Histogram</td>
<td>Shows a histogram of the image with the applied LUT (only for 12-bit or 16-bit mode in Raw or Mono)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example of histogram Pike F-032C:</td>
<td></td>
</tr>
<tr>
<td>Scroll bars</td>
<td>Use the horizontal and vertical scroll bars for scrolling the graph when it is zoomed.</td>
<td></td>
</tr>
<tr>
<td>Controls for zooming the graph</td>
<td>Use these buttons to zoom in/out the graph or the current selection of the graph.</td>
<td></td>
</tr>
<tr>
<td>Controls for saving the LUT data to a file</td>
<td>Enter file name or choose already existing file to save LUT data. When deactivating add X values check box the X value column will not be saved in the *.csv file.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong>: If working with multi-column *.csv files: <strong>Never use the Save button in the LUT editor, unless using a new file name. Only the displayed column is saved, all other columns get lost.</strong></td>
<td></td>
</tr>
</tbody>
</table>

Table 34: LUT editor: window elements
## Window element

### Controls for editing grip points

On start-up of LUT editor there are already 2 so-called grip points set which are connected with a line (linear function). You can add/delete/move grip points.

There are two moving methods: Move Along Slope and Move Freely (default). Additionally you can enter position and value for each grid point manually.

For details see:
- Chapter LUT editor: How to add a grip point on page 98
- Chapter LUT editor: How to remove a grip point on page 99
- Chapter LUT editor: How to move/edit a grip point on page 99

![Grip Points](image)

### Controls for replacing a selection with special functions

You can also replace a selection with a number of values or special functions (line, gamma, inversion, etc.) by clicking **Apply**.

For details see:
- Chapter LUT editor: How to select data on page 97
- Chapter LUT editor: How to extend a selection of data on page 98
- Chapter LUT editor: How to modify the graph between two grip points on page 100

![Selection](image)

<table>
<thead>
<tr>
<th>Window element</th>
<th>Description</th>
<th>Examples, controls, buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controls for editing grip points</td>
<td>On start-up of LUT editor there are already 2 so-called grip points set which are connected with a line (linear function). You can add/delete/move grip points. There are two moving methods: Move Along Slope and Move Freely (default). Additionally you can enter position and value for each grid point manually. For details see:</td>
<td><img src="image" alt="Grip Points" /></td>
</tr>
<tr>
<td>Controls for replacing a selection with special functions</td>
<td>You can also replace a selection with a number of values or special functions (line, gamma, inversion, etc.) by clicking <strong>Apply</strong>. For details see:</td>
<td><img src="image" alt="Selection" /></td>
</tr>
</tbody>
</table>

Table 34: LUT editor: window elements
### Window element | Description | Examples, controls, buttons
---|---|---
Edit values | Click here to open the **Edit LUT values** dialog and change each value individually. | Example of dialog for Pike F-210C

Init | Click **Init** to start with two grip points connected with a linear graph. The two initial grip points are \((0,0)\) and \((\text{max, max})\).  
- Left starting grip point is set to null by default.  
- Right starting grip point is set to the maximum LUT value by default.  
- The two starting grip points are connected by a straight line (linear) from null to the maximum LUT value. | Example of init function with Pike F-032C:

Table 34: LUT editor: window elements
Table 34: LUT editor: window elements

<table>
<thead>
<tr>
<th>Window element</th>
<th>Description</th>
<th>Examples, controls, buttons</th>
</tr>
</thead>
</table>
| Undo and Redo button           | • Click [Undo] to let the last modification of the LUT data be undone.  
• Click [Redo] to let the Undo action be undone. | Use [Undo] and [Redo] buttons to traverse through the whole history of modifications with two limitations:  
• If the LUT data is modified after undoing some actions, these actions cannot be redone.  
• If the LUT editor is closed and reopened, it is not possible to undo the actions made before closing the dialog. |
LUT editor: How to select data

**Note** With the introduction of the new grip point mechanism a region selection is only possible from grip point to grip point.

To start: click **Init**. The first two grip points are created with a linear graph between them.

To select a region (range of values between two adjacent grip points):
1. In the graph window click (with left mouse button) **outside the line**.
2. Keep left mouse button pressed and move cursor (to the right or left).
3. Release left mouse button to end selection.

The two adjacent grip points that are next to the so-marked region are taken for the current selection.

The current selection is displayed with grey background color. The elements in the Selection section are now available. (For more information see Chapter LUT editor: How to modify the graph between two grip points on page 100.)

To deactivate the current selection: click in grey background.

**LUT editor: How to extend a selection of data**

To extend a current selection:

1. Click on the vertical edge of a current selection (with grey background color) and keep left mouse button pressed.
   
   Mouse cursor changes to double-headed arrow.

    ![Figure 18: Extend current selection with mouse cursor](image)

2. Move the cursor to right or left until it snaps to the next grip point.
3. Release the left mouse button to fix the new selection.

**Note** If necessary: First add a new grip point to which the selection can be extended.

**LUT editor: New grip point mechanism**

In order to simplify the handling and editing of look-up tables a new mechanism with grip points was implemented. The usage is described in the following subsections.

**LUT editor: How to add a grip point**

To add a grip point:

1. Right-click on the graph.
   
   In the popup menu click **Insert Grip Point**.

A grip point is added directly on the graph.
LUT editor: How to remove a grip point

First way
To remove a grip point:
1. Right-click the grip point.
2. In the pop-up menu click on **Remove Grip Point**.
The grip point is removed.

Second way
To remove a grip point:
1. Move grip point onto another grip point.
The grip point is removed automatically.

LUT editor: How to move/edit a grip point

First way
To move a grid point (**Move Along Slope** method):
1. Click on the grid point.
The mouse cursor changes to ◄ and the color of the grid point changes from blue to orange.
2. In **Grip Points** section choose **Move Along Slope** option.
   In graph window click on orange grid point and keep left mouse button pressed.
   Mouse cursor changes to ◄
3. Move the cursor (horizontally to right or left).
The grid point moves along the slope of the graph.
4. Release the left mouse button to fix the grip point at the new position.

Second way
To move a grid point (**Move Freely** method):
1. Click on the grid point.
The mouse cursor changes to ◄ and the color of the grid point changes from blue to orange.
2. In **Grip Points** section choose **Move Freely** option.
3. In graph window click on an existing grip point and keep left mouse button pressed.
   Mouse cursor changes to ◄
4. Move the cursor right/left or up/down.
The grip point moves in the same direction as the mouse cursor.

Note
If the grid point is moved onto another grip point, it is removed automatically.
Operating AVT cameras with SmartView

5. Release the left mouse button to fix the new position of grip point.

**LUT editor: How to modify the graph between two grip points**

To select and modify LUT data:

1. Select data as described in Chapter **LUT editor: How to select data** on page 97 and Chapter **LUT editor: How to extend a selection of data** on page 98.

2. If the selection of data is done, proceed in the following way to modify the LUT data.

3. In the **Selection** area use the **Replace selection with** combo box:

<table>
<thead>
<tr>
<th>Choosing Modify method...</th>
<th>... does the following</th>
<th>Replace</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>... replaces the selection with a fixed value. Enter this value in the <strong>Value</strong> field or use ![image].</td>
<td>![image]</td>
</tr>
<tr>
<td>Minimum value or Maximum value</td>
<td>... changes the selection to either 0 or the maximum value supported by the camera.</td>
<td>![image]</td>
</tr>
<tr>
<td>Left value or Right value</td>
<td>... sets the selection to the first or last selected value.</td>
<td>![image]</td>
</tr>
<tr>
<td>Average value</td>
<td>... replaces the selection by its average value.</td>
<td>![image]</td>
</tr>
<tr>
<td>Line</td>
<td>... replaces the selection by a straight line from the first to the last selected value.</td>
<td>![image]</td>
</tr>
<tr>
<td>Gamma</td>
<td>... replaces the selection by a gamma function from the first to the last selected value. Enter the gamma factor in the Gamma factor field or use ![image].</td>
<td>![image]</td>
</tr>
<tr>
<td>Inversion</td>
<td>... mirrors the current selection vertically. The baseline for the mirroring is the first selected value.</td>
<td>![image]</td>
</tr>
</tbody>
</table>

**Table 35: Modify methods**

4. Click **Apply**.

The chosen modify method is applied to the selection in LUT editor window. If **Preview** check box is activated the chosen method is also applied on-the-fly to the image in SmartView window.

**Note** When moving a grip point, the graph lines connected to the moving point are set back to linear function.
Operating AVT cameras with SmartView

AVT SmartView for FirePackage V2.3.1

Working with trigger

Conditions

- During HDR mode level mode trigger (Trigger_Mode_1) is not possible.
- The multi-shot counter also controls the number of shots in Trigger_Mode_15.

Where to find

SmartView: Main window: Edit settings → Trig/IO tab

Figure 19: Trigger and Input/Output: Example (Pike F-210C)
Operating AVT cameras with SmartView

Description

All AVT cameras support IIDC conforming Trigger_Mode_0 and Trigger_Mode_1 and special Trigger_Mode_15 (bulk trigger).

Stingray/Guppy PRO cameras support software triggers (AVT-own feature) additionally: marked with -SW.

<table>
<thead>
<tr>
<th>Trigger mode</th>
<th>...also known as</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>Continuous mode</td>
<td>The camera runs with an internally generated trigger. The camera sets the shutter time according to the value set in the shutter (or extended shutter) register.</td>
</tr>
<tr>
<td>Edge mode(0)-Ext</td>
<td>Edge mode</td>
<td>The camera triggers one image precisely (aka asynchronously) with a voltage edge received via trigger pin of the I/O connector.</td>
</tr>
<tr>
<td>Edge mode(0)-SW</td>
<td>Trigger_Mode_0</td>
<td>The camera sets the shutter time according to the value set in the shutter (or extended shutter) register.</td>
</tr>
<tr>
<td>Level mode(1)-Ext</td>
<td>Level mode</td>
<td>The camera triggers one image precisely (aka asynchronously) with a voltage edge received via trigger pin of the I/O connector.</td>
</tr>
<tr>
<td>Level mode(1)-SW</td>
<td>Trigger_Mode_1</td>
<td>The camera sets the shutter time according to the active low time of the pulse applied (or active high time in the case of an inverting input).</td>
</tr>
<tr>
<td>Progr. mode(15)-Ext</td>
<td>Programmable mode</td>
<td>Is a bulk trigger, combining one external trigger event with continuous or one-shot or multi-shot internal trigger.</td>
</tr>
<tr>
<td>Progr. mode(15)-SW</td>
<td>Trigger_Mode_15</td>
<td></td>
</tr>
</tbody>
</table>

Table 36: Description of trigger modes
**Configuring trigger modes**

**Perform steps**

To configure the trigger modes do the following:

1. In **Trigger** section choose your desired mode (Internal, Edge mode(0), Level mode(1), Progr. mode(15)).

2. For Edge mode(0) or Progr. mode(15) choose the **Polarity** of the trigger signal (Falling or Rising). For level mode(1) choose the **Polarity** of the trigger signal (Low act. or High act.).

3. In **Multishot counter** section set the number of images for the camera to take in succession.

4. If you choose Edge mode(0): In **Trigger delay** section you can set a trigger delay (activate **On** check box) and a delay time in µs for the trigger signal to become effective.

5. In **Integration enable delay** section you can switch on/off (On check box) the delay of the integration enable event. Enter the delay time in µs. Use this e.g. if you fire a flash with IntEna and want to delay when the flash is fired relative to the trigger.

6. In **SW trigger** section you can set a software trigger (click Trigger).
Scenarios for trigger modes

The following scenarios show some examples when the three trigger modes are useful.

<table>
<thead>
<tr>
<th>Trigger mode</th>
<th>Typical scenario</th>
<th>Additional information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger_Mode_0</td>
<td>Moving objects to be triggered precisely at the same position.</td>
<td>Motion blur (the amount of movement during the shutter is open) may also affect the image quality. Thus a controlled and bright illumination (or flash driven by IntEna signal of camera) with a proper and short shutter time may be required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trigger_Mode_1</td>
<td>• Moving objects to be triggered precisely at the same position.</td>
<td>This mode emulates the behavior of popular analog cameras.</td>
</tr>
<tr>
<td></td>
<td>• Brightness changes to be controlled via the trigger signal itself.</td>
<td></td>
</tr>
<tr>
<td>Trigger_Mode_15</td>
<td>• Grabbing exactly one image based on the first external trigger.</td>
<td>The Technical Manuals of the cameras have in depth examples how to set up these three examples.</td>
</tr>
<tr>
<td></td>
<td>• Filling the camera's internal image buffer with one external trigger without overriding images. (By setting Multi_shot counter = #frames fitting in internal memory)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Grabbing an unlimited amount of images after one external trigger (surveillance)</td>
<td></td>
</tr>
</tbody>
</table>

Table 37: Typical scenarios for trigger modes

Configuring input/output pins

Each input pin and each output pin can be configured individually to your needs for example the above mentioned triggering of the cameras.

Perform steps To configure the input/output pins do the following:

1. In Input/Output pins section choose for every input and output pin the desired mode. To change a mode, click on the mode field. A combo box opens: click on the desired mode.

   For each pin you can choose one of the following modes:
Input ⇒ (Off/Trigger)
Output ⇒
(Off/Direct/IntegrationEnable/FrameValid/Busy/FollowInp)

2. Choose the Polarity bit in the Invert column. To change an Invert entry, click on the invert field. A combo box opens: click on No or Yes to change the Polarity bit.

Note

The former Polarity column for the input/output pins is now called Invert to clarify the use of this bit. A polarity of low in former SmartView versions is now read as Invert:No, meaning the same.

If you set more than one input for trigger, all inputs are logically ANDed.

The State column lists the status of the input/output pin (Low or High).

3. Activate ✓ Poll the I/O state continually to update the state of pins every 200 ms.
Using logging functionality of SmartView (*.cmd file)

**Conditions**
- Appropriate start option must be supplied.
- Log file is created in folder of viewer executable.

**Where to find**
Has to be done manually. See Description.

**Description**
SmartView provides a logging facility for errors that might have occurred during the operation of the program. This is helpful if you want to debug problems in cooperation of the software with the cameras and the associated hardware in question.
- The logging file is created only if an appropriate start option is supplied.
- The log file is created in the same folder as the viewer executable.

There are two options for the log file:
- It is only flushed every 8000 characters or after closing SmartView.
- It is auto-flushed when needed.

Setting via **Extras → Auto-flush logging file** (May slow down system). See Submenu **Auto-flush logging file** on page 35.

The following log levels are listed in decreasing severity and include all the log levels above them:
- `-d`: debug
- `-e`: error
- `-w`: warning
- `-i`: info
There are two ways to use the logging functionality:

**First way**  Place a link to SmartView on the desktop and modify the properties of the link accordingly.

![Figure 20: Properties dialog of SmartView](image)

**Second way**  Alternatively create a *.cmd file with the options (e.g. SmartView.exe -i) in the SmartView directory.

![Figure 21: SmartView.cmd file](image)
Channel balance (only Pike)

**Conditions**
- **All** KODAK Pike sensors: channel balance
  - (color cameras: Format_7 mode and RAW mode/no debayering)
  - (b/w cameras: Format_7 mode and Mono mode)

**Where to find**
Channel balance: Extras → Adjust channels

![Channel balance: Example (Pike F-032C)](image)

**Description**

**Pike channel balance**

**Technical background**
To achieve more speed, the Kodak sensors of the Pikes are read out horizontally via two separate channels, so two ADCs are involved which may have to be configured differently. A standard adjustment between the channels is done at production time, but under certain circumstances, an intensity step might still be visible from left to right.

**Perform steps**
To be able to make the step disappear, there is an extra dialog available from the viewer window.
To carry out an adjustment (offset adjustment + gain adjustment) in SmartView, perform the following steps:

1. In SmartView click **Extras → Adjust channels...** or use Alt+Ctrl+A.

The following window opens:

2. Put on lens cap.
3. Set gain adjustment slider and offset adjustment slider to 0.
4. Click several times **Offset adjustment** until the slider does not move any more.
5. Put off lens cap.
6. Take test sheet with vertical continuous b/w gradient, defocus lens and start image acquisition.
7. Activate **Gain auto adjustment**.

Now left and right channel should be adjusted for all grey values, so that vertical line is no more visible.

**Note**

Channel adjustment should be done in the same gain region as in your real application. If you use a much greater gain in your application, it may be necessary to do the dual-tap offset adjustment again.

Dual-tap offset adjustment is done once in the AVT factory and saved via **Program** button in User set 0.

The **Program** button is not available for the user.
Note

For more information read *Pike Technical Manual*, Chapter Channel balance.
Using HDR mode (CMOS cameras)

**Conditions**
- Guppy F-036: HDR mode of Micron MV022 sensor
- Marlin F-131: HDR mode of FillFactory IBIS5B sensor
- For HDR mode: number of knee points must be greater than 0.

**Where to find**
HDR: Edit settings → CMOS tab, Section High dynamic range mode

**Description**

**Guppy F-036: Micron MV022 HDR mode**

The **HDR mode** of the **Micron MV022** sensor allows for **two** knee points. They are controllable in an **easy mode**, which means that the draining voltage may be set for both knee points (measured from the minimum voltage) and the time is assigned automatically by the sensor.

**Perform steps**

On **CMOS** tab:
1. Enter voltage levels from 0 to 31.
   A value of 0 means 0.5625 Volt (each step meaning an increase of 0.0625 Volt).
2. If you select two knee points, the second value must be less than or equal to the first value.
**Marlin F-131: IBIS5B HDR mode**

The **HDR mode** of the IBIS5B sensor allows for three knee points. This enables the high dynamic range of the sensor to be compressed into 8 bit, preserving interesting details of the image. This mode is also known as multiple slope (dual slope).

**Perform steps** On **CMOS** tab:

1. Change number of knee points to value greater 0 (Example: 2).
2. Activate **HDR mode on** check box.
3. In **Easy mode** put slider in the desired position (the knee point values will be set automatically).
   - In **Expert mode** enter values for **Add.time #1** (#2, #3) manually.
4. Activate **Display graph** check box to display the **HDR Graph** window.

**Note** For more information read:

- Chapter **CMOS tab descriptions** on page 58, Section **High dynamic range mode (only Guppy F-036)**
- **Guppy Technical Manual**, Chapter **HDR (high dynamic range) (Guppy F-036 only)** [approx. 5 pages]
Operating AVT cameras with SmartView

Note

For more information read:

- Chapter CMOS tab descriptions on page 58, Section High dynamic range mode (only Marlin F-131)
- Marlin Technical Manual, Chapter IBIS5A multiple slope (High Dynamic Range mode).
Error Messages and FirePackage Error Flags

We analyze and discuss the data flow from an AVT camera (e.g. Marlin) to the main memory of a PC under Windows™ using AVT FirePackage assuming a FireGrab or FireStack based implementation like e.g. SmartView. First we notice a frame buffer in the camera, which can hold usually more than one image in the camera. The frame memory is constructed as a FIFO (first in first out) memory. Frame buffer(s) in a camera are beneficial for the sensor handling as well as for additional features (such as deferred image transfer). A frame buffer in the camera is not primarily intended or needed for secure data flow aspects.

The frame memory is followed by a much smaller FIFO buffer (size of 4 kByte) in the 1394 interface (link chip) to buffer the data prepared to send of about one 1394 cycle.

Data then is sent via a DMA mechanism to the corresponding 1394 receive buffer in the PC, which has also usually the size of 4 kByte.

Speed of the PCI (express) bus is high enough and latency of it is usually very low so that no overflow or underflow of Receive-FIFO is occurring.
A block diagram of the incoming receive OHCI chip (by TI) interface shows the details:

Figure 26: Block diagram of incoming receive OHCI chip (by TI)

If an error occurs, the Receive FIFO is most probably the critical section. Other devices of the PC, such as network adapter or USB or peripheral devices may also occupy the PCI bus so that the performance for the 1394 part can be negatively influenced or becomes too low.

Debugging this situation requires the temporal deactivation of these peripheral devices accompanied by lowering the packet payload of the 1394 device. With the use of MS low level device driver for 1394 ports, errors in the low level data flow which are created by the hardware such as Receive-FIFO overflows are not reported to the application.

FirePackage on the other hand replaces the MS device driver by a specific (monolithic) driver for the 1394 device class which fully reports errors to the application. The following is a list of the various error messages, generated by the driver and the associated dlls.
While it is not the purpose of this document to explain each and every theoretically possible error, it might be helpful in the event of debugging to communicate the exact error messages to the support staff.

**Error codes returned by functions**

Every function returns a 32-bit error code that contains additional information about the error.

The module differs between upper layer error codes (that start with FCE_xxx) and low level error codes that start with (HALER_xxx).

The following two tables show the coding and describes each error.

### HALER_xxx codes

<table>
<thead>
<tr>
<th>Error name</th>
<th>Number</th>
<th>Error description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HALER_NOERROR</td>
<td>0</td>
<td>No error.</td>
</tr>
<tr>
<td>HALER_NOCARD</td>
<td>1</td>
<td>No hardware found.</td>
</tr>
<tr>
<td>HALER_NONTDEVICE</td>
<td>2</td>
<td>No logical device could be created for the card (memory problem).</td>
</tr>
<tr>
<td>HALER_NOMEM</td>
<td>3</td>
<td>Not enough memory for this operation.</td>
</tr>
<tr>
<td>HALER_MODE</td>
<td>4</td>
<td>Wrong mode for this operation.</td>
</tr>
<tr>
<td>HALER_TIMEOUT</td>
<td>5</td>
<td>Time-out occurred.</td>
</tr>
<tr>
<td>HALER_ALREADYSTARTED</td>
<td>6</td>
<td>Device was already started and cannot be started twice.</td>
</tr>
<tr>
<td>HALER_NOTSTARTED</td>
<td>7</td>
<td>Device was not started.</td>
</tr>
<tr>
<td>HALER_BUSY</td>
<td>8</td>
<td>Device is busy at present.</td>
</tr>
<tr>
<td>HALER_NORESOURCES</td>
<td>9</td>
<td>Not enough resources (no more interrupts, no threads etc.).</td>
</tr>
<tr>
<td>HALER_NODATA</td>
<td>10</td>
<td>There is no data to acquire.</td>
</tr>
<tr>
<td>HALER_NOACK</td>
<td>11</td>
<td>No acknowledge received from the target.</td>
</tr>
<tr>
<td>HALER_NOIRQ</td>
<td>12</td>
<td>Expected an interrupt but there was none.</td>
</tr>
<tr>
<td>HALER_NOBUSRESET</td>
<td>13</td>
<td>Expected a firewire bus reset but there was none.</td>
</tr>
<tr>
<td>HALER_NOLICENSE</td>
<td>14</td>
<td>No license to perform this action.</td>
</tr>
<tr>
<td>HALER_RCODEOTHER</td>
<td>15</td>
<td>Response code of target for actual requested subaction other then RCODE_COMPLETE (response code is also returned).</td>
</tr>
<tr>
<td>HALER_PENDING</td>
<td>16</td>
<td>Something has been started and is in a pending state.</td>
</tr>
</tbody>
</table>

Table 38: HALER_xxx codes
### Table 38: HALER_xxx codes

<table>
<thead>
<tr>
<th>Error name</th>
<th>Number</th>
<th>Error description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HALER_INPARMS</td>
<td>17</td>
<td>Error in input parameter (mostly range error).</td>
</tr>
<tr>
<td>HALER_CHIPVERSION</td>
<td>18</td>
<td>Wrong chip version for this function.</td>
</tr>
<tr>
<td>HALER_HARDWARE</td>
<td>19</td>
<td>Hardware error.</td>
</tr>
<tr>
<td>HALER_NOTIMPLEMENTED</td>
<td>20</td>
<td>Function is not implemented.</td>
</tr>
<tr>
<td>HALER_CANCELED</td>
<td>21</td>
<td>A waiting function was cancelled by another user call.</td>
</tr>
<tr>
<td>HALER_NOTLOCKED</td>
<td>22</td>
<td>A device is unlocked and needs to be locked for this action.</td>
</tr>
<tr>
<td>HALER_GENERATIONCNT</td>
<td>23</td>
<td>A function for asynchronous communication was called after a bus reset without having called <code>&lt;FCTLGetBus-Info&gt;</code> in order to get the new addresses of all existing nodes.</td>
</tr>
<tr>
<td>HALER_NOISOMANAGER</td>
<td>24</td>
<td>Function requires an isochronous resource manager but there is none.</td>
</tr>
<tr>
<td>HALER_NOBUSMANAGER</td>
<td>25</td>
<td>Function requires a bus manager but there is none.</td>
</tr>
<tr>
<td>HALER_UNEXPECTED</td>
<td>26</td>
<td>Internal processing error, unexpected value detected.</td>
</tr>
<tr>
<td>HALER_REMOVED</td>
<td>27</td>
<td>Target for command was removed.</td>
</tr>
<tr>
<td>HALER_NOBUSRESOURCES</td>
<td>28</td>
<td>Either no isochronous channel or isochronous bandwidth available.</td>
</tr>
<tr>
<td>HALER_DMAHALTED</td>
<td>29</td>
<td>An isochronous receive DMA has been halted.</td>
</tr>
</tbody>
</table>

### Table 39: FCE_xxx codes

<table>
<thead>
<tr>
<th>Error name</th>
<th>Number</th>
<th>Error description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCE_NOERROR</td>
<td>0</td>
<td>No error</td>
</tr>
<tr>
<td>FCE_ALREADYOPENED</td>
<td>1001</td>
<td>Device is already open and cannot be opened twice.</td>
</tr>
<tr>
<td>FCE_NOTOPENED</td>
<td>1002</td>
<td>Device must be opened before.</td>
</tr>
<tr>
<td>FCE_NODETAILS</td>
<td>1003</td>
<td>No details for this error</td>
</tr>
<tr>
<td>FCE_DRVNOTINSTALLED</td>
<td>1004</td>
<td>Kernel mode driver not installed.</td>
</tr>
<tr>
<td>FCE_MISSINGBUFFERS</td>
<td>1005</td>
<td>Not enough buffers for the requested isochronous communication.</td>
</tr>
<tr>
<td>FCE_INPARMS</td>
<td>1006</td>
<td>Error in input parameters (mostly range error).</td>
</tr>
<tr>
<td>FCE_CREATEDEVICE</td>
<td>1007</td>
<td>Error creating a logical device to connect to the kernel mode driver.</td>
</tr>
<tr>
<td>FCE_WINERROR</td>
<td>1008</td>
<td>Internal windows error.</td>
</tr>
<tr>
<td>FCE_IOCTL</td>
<td>1009</td>
<td>Error while calling kernel mode driver.</td>
</tr>
</tbody>
</table>
Error flags in global error field

Error codes are returned when a function is called. Error flags are something different. During processing in the background there is a potential risk that an error occurs. This error can not be assigned to any function. So these is handled by the error flags. One or more error flags are set when an error occurs and are stored within a 32-bit field.

When an application wants to be notified this bit field is posted to the application with an WPARAM_ERROR message. In the 32-bit field each bit has a specific meaning. The following table shows the bit values and explains their meaning.

**HALERF_xxx**

<table>
<thead>
<tr>
<th>Error name</th>
<th>Value</th>
<th>Error description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HALERF_RXHLTISO0</td>
<td>0x00000001</td>
<td>Isochronous RXDMA0 had to be stopped.</td>
</tr>
<tr>
<td>HALERF_RXHLTISO1</td>
<td>0x00000002</td>
<td>Isochronous RXDMA1 had to be stopped.</td>
</tr>
<tr>
<td>HALERF_RXHLTISO2</td>
<td>0x00000004</td>
<td>Isochronous RXDMA2 had to be stopped.</td>
</tr>
<tr>
<td>HALERF_RXHLTISO3</td>
<td>0x00000008</td>
<td>Isochronous RXDMA3 had to be stopped.</td>
</tr>
<tr>
<td>HALERF_RXHLTISO4</td>
<td>0x00000010</td>
<td>Isochronous RXDMA4 had to be stopped.</td>
</tr>
<tr>
<td>HALERF_RXHLTISO5</td>
<td>0x00000020</td>
<td>Isochronous RXDMA5 had to be stopped.</td>
</tr>
</tbody>
</table>

Table 40: HALERF_xxx
### Error name | Value | Error description
--- | --- | ---
HALERF_RXHLTISO6 | 0x00000040 | Isochronous RXDMA6 had to be stopped.
HALERF_RXHLTISO7 | 0x00000080 | Isochronous RXDMA7 had to be stopped.
HALERF_ISORXACK | 0x00000100 | Isochronous DMA reported error in packet ACK
HALERF_ISORX | 0x00004000 | Unspecified isochronous receive error.
HALERF_TXRESPONSE | 0x00008000 | Could not send a response for a request (Read or Write).
HALERF_ASYRX | 0x00010000 | Error during asynchronous reception.
HALERF_ASYTX | 0x00020000 | Error during asynchronous transmission.
HALERF_PHYTIMEOUT | 0x00040000 | The Phy took too long to transfer an information to the Linklayer chip.
HALERF_HDRERROR | 0x00080000 | A packet with an unknown header was received.
HALERF_TCERROR | 0x00100000 | Packet with unknown TCode was received.
HALERF_ATSTUCK | 0x00200000 | Asynchronous transmit FIFO stucked.
HALERF_GRFOVERFLOW | 0x00400000 | General receive FIFO overflowed (access to PCI bus too slow)
HALERF_ITFUNDERFLOW | 0x00800000 | Isochronous transmit FIFO underflow (access from PCI bus too slow)
HALERF_ATFUNDERFLOW | 0x01000000 | Asynchronous transmit FIFO underflow (access from PCI bus too slow)
HALERF_PCIERROR | 0x02000000 | Error while accessing PCI bus.
HALERF_ASYRXRESTART | 0x04000000 | Error in asynchronous transmit state machine. Transmission had to be restarted.
HALERF_NOACCESSINFO | 0x08000000 | No access info could be allocated while an external access occurred.
HALERF_SELFID | 0x10000000 | Error while receiving SelfIds.
HALERF_DMPORT | 0x20000000 | Error in data mover port (GP-Lynx only)
HALERF_ISOTX | 0x40000000 | Error in isochronous transmission.

Table 40: HALERF_xxx
Setting AOI (Format_7 settings)

Definition  AOI = area of interest

Area of interest readout (AOI) refers to a camera function whereby only a portion of the available pixels are read out from the camera. For example, it is possible to read out a 640 x 480 pixel area of pixels from a camera that has a total resolution of 1628 x 1236. The result is a much faster frame rate and less data to be processed. This is also referred to as partial scan. Various autofunctions (auto shutter, auto gain, auto white balance) act on the AOI.

Conditions
- Camera has to be in Format_7 mode

Where to find
SmartView: Edit settings → Format tab (Section Format7 settings)

Figure 27: Setting AOI (Format_7 settings): Example Pike F-210C
Description

The image sensor on the camera has a defined resolution. This indicates the maximum number of lines and pixels per line that the recorded image may have.

However, often only a certain section of the entire image is of interest. The amount of data to be transferred can be decreased by limiting the image to a section when reading it out from the camera. At a lower vertical resolution the sensor can be read out faster and thus the frame rate is increased.

Note: The setting of AOIs is supported only in video Format_7.

While the size of the image read out for most other video formats and modes is fixed by the IIDC specification, thereby determining the highest possible frame rate, in Format_7 mode the user can set the upper left corner and width and height of the section (AOI=area of interest) he or she is interested in to determine the size and thus the highest possible frame rate.

SmartView offers a convenient procedure for the selection of an AOI in the Format tab.

After selecting a Format_7 mode the selection is available. You can choose a subwindow and its position according to your needs. IIDC specifies for Format_7 that the transferred packet size has to be adjustable. This is reflected in the packet size slider which allows to limit the packet size (the amount of image data, which is transmitted from the camera every 125 microseconds). Lowering this packet size leads to a lower max. frame rate as displayed in the box.
In addition to the area of interest, some other parameters have an effect on the maximum frame rate:

- Time for reading the image from the sensor and transporting it into the FRAME_BUFFER
- Time for transferring the image over the FireWire™ bus
- Length of the exposure time
Calculating frames per second

Conditions
- Acquiring images (one-shot, multi-shot, continuous)

Where to find
View → Status bar
The current frame rate is displayed in the status bar.

Description
AVT implemented a new frame rate calculation. The following chapter explains the difference between theoretical and displayed frame rate.

New Frame rate calculation
In order to transfer the possible frame rate there is a new way to calculate the MaxBPP.

The maximum number of packets to be transferred with MaxFPS is determined. From this MaxBPP is calculated.

It is possible, that one cycle is dropped between two images. Nevertheless the frame rate formula can be used (Technical Manual, Chapter Frame rates Format_7). MaxFPS of sensor will be reached.

Example: calculation of frame rate (SmartView vs. Camera)
Calculation of MaxPPF: 
PPF = 1 / (MaxFPS x 125µs) = 38.29
Round off ⇒ PPF = 38
Calculation MaxBPP: MaxBPP = 640 x 480 / 38 = 8084.21
This value will be rounded up to N-quadlets: MaxBPP = 8088
Status bar counters

Usually there is one counter to be seen at the bottom right hand side in the status bar of the viewing window which counts all frames sent from camera. Under practical circumstances it can happen that SmartView could not process and display all images from the camera or that even the driver could not reassemble all images from the camera.

Conditions
This usually indicates problems in the hardware or the software such as
- Problems with the cabling (transmission errors)
- Bandwidth over the 1394 bus(es) exceeded
- PCI (Express) bus bandwidth exceeded
- PCI latency problems
- Problems with power consumption reduction options like Intel Speed Stepping or AMD PowerNow or Cool’nQuiet, resulting in overflows of receiving FIFO
- CPU resources problems

Where to find
View → Status Bar

Description
If there are three numbers displayed, not all frames arriving on the card could be processed and displayed.
- The first (left) number now shows the number of frames arrived at the card. (5077 in figure below)
- The **second number** shows the number of frames lost on driver level (e.g. due to receive FIFO overflows) (0 in figure below).
- The **third number** shows the number of frames lost due to poor processing capability. (37 in figure below).

The frame rates shown still show the frame rate at the card and, if there is a second frame rate, the right one shows the processed frame rate.

The screenshot shows one example which was produced in a **multi-camera environment** leaving the Bayer demosaicing to the PC and forcing it to the most challenging algorithms. As a consequence SmartView was not able on this PC to keep up with all the frames from the cameras.
Format_7 mode mapping (only Stingray/Pike/Guppy PRO F-503)

In Stingray/Pike/Guppy PRO (F-503) cameras, you can customize your Format_7 layout with respect to binning (only b/w) or sub-sampling (b/w and color) via the so-called Format_7 mapping. Format_7 Mode_0 is factory setting (full resolution) and cannot be changed.

Note: For a detailed description of mapping to Format_7 Mode_1 ... Mode_7 see Stingray/Pike/Guppy PRO Technical Manual, Chapter Binning and sub-sampling access.

Conditions
- Binning: Stingray/Pike/Guppy PRO F-503 b/w camera
- Sub-sampling: Stingray/Pike/Guppy PRO F-503 b/w or color camera

Where to find
SmartView entry window: Menu Camera → Format 7 mapping...

Figure 31: Format_7 mode mapping
Description

To map one or more modes to F7M1 ... F7M7 do the following:

1. In SmartView entry window click on Camera → Format 7 mapping...
   The following window opens:

   ![Format 7 Mode Mapping Window](image)

   - **Figure 32: Format_7 mode mapping window**

   2. Choose your mappings and click on Apply.

   **Note**

   **Examples for abbreviations:**
   - **H** means horizontal; **V** means vertical
   - **2H binning** means 2 x horizontal binning
   - **2/4 H sub-sampling** means 2 out of 4 horizontal sub-sampling
   - **F7M1** means Format_7 Mode_1
### Decimation Type

<table>
<thead>
<tr>
<th>Decimation Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled</td>
<td>Chosen mode disappears from the Format_7 mode list.</td>
</tr>
</tbody>
</table>
| Default         | Factory settings are used:  
F7M1: 2H binning  
F7M2: 2V binning  
F7M3: 2H, 2V binning  
F7M4: 2/4 H sub-sampling  
F7M5: 2/4 V sub-sampling  
F7M6: 2/4 H, 2/4 V sub-sampling |

### Binning

Choose binning factors from combo boxes below.  
- full resolution  
- 2  
- 4  
- 8

### Sub-sampling

Choose sub-sampling factor from combo boxes below.  
- full resolution  
- 2/4  
- 2/8  
- 2/16

Table 41: Decimation types

For an overview of the available modes, click on **Camera mode info**.  
For Pike cameras the following window opens:

![Camera mode info window](image)

Figure 33: Camera mode info window (left: b/w; right: color Pike cameras)
When saving settings to an XML file, a hash value is calculated and stored for each Format_7 mode, so that it is not possible to read illegal settings for a re-mapped mode. This has of course no impact on old settings files. In this case, illegal settings could be re-read.
Packed 12-Bit Modes
(only Stingray/Pike/Guppy PRO)

For Stingray/Pike/Guppy PRO cameras special Packed 12-Bit modes are available.

Conditions
- Stingray/Pike/Guppy PRO b/w camera: MONO12 (color ID 132)
- Stingray/Pike/Guppy PRO color camera: RAW12 (color ID 136)

Where to find
SmartView: Edit settings → Format tab (b/w: MONO12; color: RAW12)

Description
The new Packed 12-Bit Modes are only available in Format_7. At RAW12 color mode there is only 2x2 debayering available. For a detailed description see Stingray/Pike/Guppy PRO Technical Manual, Chapter Packed 12-Bit Mode.
Sequence mode (Stingray, Pike, Marlin)

Definition  Sequence mode is a concept where the camera holds a set of different image parameters for a sequence of images. The parameter set is stored volatile in the camera for each image to be recorded. This sequence of parameter sets is simply called a sequence. The advantage is that the camera can easily synchronize this parameter set with the images so that no uncertainty can occur.

Additional information
For additional information on the sequence mode feature read the following chapters:

- Stingray Technical Manual, Chapter Sequence mode
- Pike Technical Manual, Chapter Sequence mode
- Marlin Technical Manual, Chapter Sequence mode

Conditions
- Stingray camera
- Pike camera
- Marlin camera
Where to find

Extras → Sequence dialog...

Perform steps

We show you an example how to work with the sequence editor (see screen-shots above). Our aim is to set up a sequence with eight different image settings (varying shutter from 1000...300 in steps of 100).

1. In SmartView main window click Extras → Sequence dialog...

The sequence editor opens.
2. Click **Get current settings**.
   The currently valid camera settings are gathered and put:
   – into the row, in which the mouse cursor is currently positioned or
   – after the last row (if no row element is selected)

3. Click 7x **Get current settings**.
   You now have a list of 8 identical rows, named Step 1...8 (first column).
   All parameters that are part of sequence steps are listed in the header row of the table (Step, RepCnt, StepMode, ... , Output4). Scroll to the right to see all parameters.

4. Go to **Shutter** column, click the second entry and type 900, click the third entry and type 800 ... click the 8th entry and type 300.
   You have now set up a sequence going from shutter value 1000 ... 300 in steps of 100.
   Changing parameters that are part of sequence steps do not change the settings inside the camera immediately, but in case of clicking **Apply Sequence** button.

5. Click **Apply Sequence** to start the sequence.
   The whole list of settings is sent to the camera and the sequence mode is started. **SEQ** is displayed in the status bar of the viewer window.

6. If you want to disable the current sequence click **Disable Sequence**. If you want to enable the sequence again click **Apply Sequence**.

7. Only Pike: To determine the behavior of the sequence mode with external control additionally to triggering: Go to **I/O** tab and change the Mode of Input 1 or 2 to **SeqStep** or **SeqReset**. For more information see **Pike Technical Manual**, Chapter Which new sequence mode features are available?

---

**Note**
With SmartView do not try out steps altering parameters concerning the transfer via 1394.

Use only steps that do not alter the image format or bandwidth.
Secure image signature (SIS) (Marlin, Pike, Stingray)

**Definition**
Secure image signature (SIS) is the synonym for data, which is inserted into an image to improve or check image integrity.

**Additional information**
For additional information on the secure image signature (SIS) feature read the following chapters:
- Marlin Technical Manual, Chapter Secure image signature (SIS)
- Pike Technical Manual, Chapter Secure image signature (SIS)
- Stingray Technical Manual, Chapter Secure image signature (SIS)

**Conditions**
- Marlin camera (cycle time, trigger count, frame count)
- Pike camera (additional SIS features compared to Marlin)
- Stingray camera (additional SIS features compared to Marlin)
Where to find

SmartView: Edit settings → Adv2 tab (Image stamp & counters ☑ Enable)

Description

To activate secure image signature (SIS) perform the following steps:
1. In SmartView window click Adv2 tab.
2. In Image stamp & counters section activate ☑ Enable check box.
3. For displaying frame/trigger counter numbers activate Display ☑ check box.

For more information see Secure image signature (SIS) & counters on page 54.
Smear reduction (only Pike)

**Definition**  Smear is an undesirable CCD sensor artefact creating a vertical bright line that extends above and below a bright spot in an image.

**Implementation**  Smear reduction is a new feature of Pike cameras: it is a function implemented in hardware in the camera itself to compensate for smear.

**Additional information**  For additional information on the smear reduction feature read the following chapter:
- Pike Technical Manual, Chapter Smear reduction

**Conditions**  
- Pike camera: Use only if smear appears in your images.

**Where to find**  
SmartView: Edit settings → Adv3 tab (Smear reduction  ✓ Enable)

![Figure 37: Format tab: Packed 12-bit Mode (Pike F-210C: RAW12)](image)

**Description**  
Use this function only if smear appears in your images. To activate smear reduction, perform the following steps:
1. In SmartView (Edit settings) window click Adv3 tab.
2. In Smear reduction section activate ✓ Enable check box.
Index

Numbers

1394a .............................................................. 38
1394b .............................................................. 38
16-bit images .................................................. 68
2x2 algorithm .................................................. 63
2x2 LCAA
   (Debayering algorithm) ............................... 64
2x2 LCAA+V (Debayering algorithm) ................. 64
2x2 mono (Debayering algorithm) .................... 64
2x2 pixel basis ............................................... 64
2x2 YUV422 (Debayering algorithm) ................. 64
2x2 (Debayering algorithm) .................. 64
32-bit error code .......................................... 116
3x3 pixel basis ............................................... 64
3x3 (Debayering algorithm) .................. 64

A

a table for...
   (LUT) ................................................................ 87
Absolute time of exposure .......................... 51
Active image .................................................. 51
Address column .............................................. 62
Add.time #1
   HDR IBIS5B .................................................. 112
Add.time #2
   HDR IBIS5b .................................................. 112
Add.time #3
   HDR IBIS5B .................................................. 112
adjust brightness ............................................ 41
adjust channels (Pike) ................................. 108
adjust electronic shutter ................................ 41
adjust gain .................................................... 41
adjust Hue ...................................................... 44
adjust Saturation ............................................ 44
Adv 1 tab .......................................................... 51
Adv 1 (SmartView tab) ...................................... 26
Adv 2 tab .......................................................... 53
Adv 2 (SmartView tab) ...................................... 26
Adv 3 tab .......................................................... 56, 57
Adv 4 (SmartView tab) ...................................... 26
advanced white balance ................................. 45
   example ......................................................... 66
   only Guppy color interlaced ......................... 66
algorithms ...................................................... 63
debayering .................................................... 64
AMD PowerNow ............................................. 124
AOI
   configure ...................................................... 120
   max frame rate ............................................. 40
   that is Format_7 settings .............................. 120
AOI height ..................................................... 40
AOI settings (Format7 settings) ...................... 40
AOI upper left corner .................................... 40
AOI width ........................................................ 40
AOI (definition) .............................................. 120
AOI (Format_7 settings) ................................. 120
aperture ......................................................... 77
Apply Sequence .............................................. 133
area of interest (AOI) .................................... 120
auto exposure ................................................. 41
auto gain range ............................................. 43
auto shutter range ........................................ 43
Auto size
   packet size ................................................... 40
Auto-flush logging file ................................. 106
auto-flushed .................................................. 106
auto-function AOI .......................................... 43
AVT FirePackage ............................................. 114
AVT timebase ................................................ 51
AVT’s spreadsheet LUTs .................................... 86

B

best file format
   bmp ............................................................. 69
BGR ............................................................... 65
big endian format .......................................... 72
binning
   Format_7 mode mapping ................................ 126
Bitrate ............................................................ 53
Blemish correction ........................................ 53
Blemish pixel .................................................. 60
block diagram
   Marlin b/w camera ....................................... 114
   receive OHCI chip ........................................ 115
   TSB12LV26 .................................................. 115
BMP ............................................................... 68
   usage .......................................................... 69
Both on ........................................... 53
bright illumination
  Trigger_Mode ...104
brightness ........................................ 41
IIIDC register ................................... 41
increase ........................................ 41
level ........................................... 80, 83
LUT ........................................... 85
nonlinear .................................... 85
brightness changes
  Trigger_Mode ................................104
Build
  DSNU/blemish pixel correction image ... 60
built-in color correction matrix ........... 54
bulk trigger .................................. 102
Busy ........................................... 105

C
Camera reset ................................... 55
channel balance
  KODAK Pike sensors .......................... 108
channel balance (Pike) ......................... 108
technical background .......................... 108
channel balance (screenshot) ............... 108
Char length .................................. 53
Clear flash .................................... 50
closing aperture ............................... 77
cmd files ..................................... 106
CMOS
  HDR mode ................................... 111
CMOS tab ..................................... 58
CMOS tab (HDR mode) ......................... 111
Color .......................................... 38, 54
Color correction .............................. 54, 56
color correction matrix ....................... 54
color fringe ................................... 64
color ID 132 ................................... 130
color ID 136 (RAW12) ......................... 130
color low-pass filtering ....................... 64
color modes .................................. 38
color progressive ............................. 63
configure AOI ................................ 120
configure input/output pins ................. 104
continuous mode (internal trigger) ....... 102
contrast of image ............................ 77
contrast tables ................................ 87
Control 1 (SmartView tab) ................. 26
Control 2 (SmartView tab) ................. 26
Control 3 (SmartView tab) ................. 26
Cool’nQuiet ................................... 124
correction data
  shading ...................................... 79
Correction matrix ............................ 56
correction matrix ............................ 54
CPU resources problems ..................... 124
Ctrl 1 tab .................................... 41
Ctrl 2 tab .................................... 42
Ctrl 3 .......................................... 26
Ctrl 3 tab
  interlaced cameras .......................... 45
Ctrl 1 .......................................... 26
Ctrl 2 .......................................... 26
Ctrl 3 .......................................... 63
  progressive cameras ....................... 44
Ctrl+Shift+H (Histogram) ..................... 75
Current file name ............................ 71
Cyan/Magenta ................................ 66
slider .......................................... 45
cycle time ................................... 134

D
Debayering .................................... 38, 63
  choosing type ................................ 63
Debayering algorithm
  2x2 ........................................... 64
  2x2 LCAA ................................... 64
  2x2 LCAA+V ................................ 64
  2x2 mono .................................... 64
  2x2 YUV422 ................................ 64
  3x3 .......................................... 64
debayering algorithms
  description .................................. 64
Debounce column .............................. 48
deprecation .................................. 106
deep images ................................... 68, 71
definition ...................................... 71
defect pixel correction
  only Guppy F-503 ......................... 60
  only Guppy PRO F-503 ................... 60
  only Pike .................................. 57
  only Stingray ............................... 57
Deferred transport .......................... 52
definition
  AOI .......................................... 120
deep images ................................... 71
sequence mode ........................................... 131
smear .................................................... 136
Delete correction data ................................ 60
DIB........................................................... 68
Direct...................................................... 105
Direct Access
  SmartView ............................................ 27
Direct access
description ........................................... 62
Direct register Access
  SmartView ............................................ 27
Disable Sequence .................................... 133
Display graph
  HDR Marlin F-131 .................................. 59
display of frame rate
  status bar ........................................... 123
DMA mechanism ....................................... 114
document history....................................... 7
DSNU correction .....................................  60
DSNU/Blemish pixel correction .................... 60

E
-e (logging file) ........................................... 106
Easy mode
  HDR Marlin F-131 .................................  59
  HDR (Marlin F-131) ............................... 112
easy mode (HDR Guppy) ........................... 111
edge mode (Trigger_Mode_0) ...................... 102
Edge mode(0) ........................................ 46, 103
Edit Settings
  SmartView ............................................ 26
Edit settings
  Ctrl3 tab ........................................... 63, 66
  Format tab ........................................... 37, 63
Edit settings window
  overview ........................................... 37
Edit (LUT Editor) .................................... 49
  enhanced dynamic ................................ 72
error code ............................................ 116
error codes
  FCE_xxx codes .................................... 117
  HALER_xxx codes ................................ 116
error field ............................................ 118
Error flags
  global error field ................................ 118
  error flags ....................................... 114
  error messages ................................... 114
  error (logging file) ............................... 106
Expert mode
  HDR Marlin F-131 ................................. 59
  HDR (Marlin F-131) ............................... 112
Express .............................................. 114
extended histogram ................................ 72
Extended shutter .................................... 51
extended shutter
  Trigger mode ........................................ 102
eXtensible Markup Language ....................... 73
Extra features during debayering .................. 44

F
-f (logging file) ........................................... 106
Falling .................................................. 46, 103
Fast capture .......................................... 52
faster algorithm ..................................... 64
fastest algorithm .................................... 64
fatal (logging file) .................................... 106
FCE_xxx codes ........................................ 117
field integration ..................................... 66
FIFO size .............................................. 52
FIFO used ............................................. 52
FIFO (first in first out) memory ................. 114
File name options ................................... 71
FireGrab ............................................... 114
FirePackage .......................................... 114, 115
error flags ............................................ 114
  hardware conditions ............................. 15
  installing ......................................... 17
  operating system ................................ 16
  overview .......................................... 16
FireStack .............................................. 114
first steps
  SmartView .......................................... 20
Fixed formats ........................................ 38
fixed resolutions .................................... 38
Fixed & variable modes ............................. 38
Flash ................................................... 50
flash memory ........................................ 77
flat field correction
  (shading correction) .............................. 77
FollowInp ............................................ 105
Format .................................................. 38
Format tab .......................................... 37, 63
  AOI settings ...................................... 120, 130
descriptions .......................................... 38
Format (SmartView tab) ....................... 26
Format_7 mode mapping ...................... 126

AVT SmartView for FirePackage V2.3.1

139
binning ............................................ 126
sub-sampling ..................................... 126
Format_7 modes .................................. 38
Format_7 (AOI) .................................... 120
FPGA ..................................................... 52
fps ....................................................... 123
frame buffer(s) ..................................... 114
frame count ...................................... 134
Frame Counter .................................... 54
frame integration .............................. 67
frame rate calculation .......................... 123
frame rate (display) ............................ 123
frame rates in fixed modes ..................... 38
Framerate ............................................. 123
frames per second ................................ 123
FrameValid .................................... 105
FRAME_BUFFER ..................................... 122
further steps
  SmartView ......................................... 26

G

gain .................................................... 41
gamma .................................................. 41
Gamma LUT
  incoming/outgoing bits ....................... 85
gamma LUT .......................................... 85
gamma tables ..................................... 87
GIF ..................................................... 68
  usage ................................................ 69
global error field ................................ 118
grating exactly one image
  Trigger_Mode_15 ................................ 104
grating unlimited images ..................... 104
Green/Cyan ........................................ 66
  slider .............................................. 45
Guppy color interlaced
  advanced white balance ....................... 66
Guppy F-036
  HDR mode ........................................ 111

H

HALERF_xxx error codes .......................... 118
HALER_xxx codes .................................. 116
hardware conditions
  FirePackage ....................................... 15
HDR Guppy
  easy mode ........................................ 111
  HDR mode ........................................ 111
  CMOS tab ......................................... 111
  Guppy F-036 ...................................... 111
  IBIS5B ............................................. 112
  Marlin F-131 ..................................... 112
  Micron MV022 .................................... 111
HDR mode on
  (check box) ...................................... 112
HDR (Guppy F-036)
  technical background .......................... 111
Height ............................................... 40
High act. .......................................... 46, 103
High dynamic range mode
  (only Guppy F-036) ................................ 58
  (only Marlin F-131) ................................ 59
  (section) ......................................... 111
High SNR mode ................................... 38
High (status) .................................... 105
histogram
  description ....................................... 76
  example .......................................... 76
Hold images ...................................... 52
horizontal color fringe ........................ 64
Hue .................................................. 42, 44
  definition ........................................ 42
  hue ................................................ 63

I

-i (logging file) .................................... 106
IBISSB
  HDR mode ......................................... 112
IBISSB sensor
  three knee points ............................. 112
IEEE 1394 adapter
  installing ....................................... 16
image buffer ..................................... 104
Image stamp & counters (Section) ............ 135
images
  enhanced dynamic .............................. 72
  save .............................................. 68
  save as .......................................... 68
  streaming ........................................ 68
images to send .................................. 52
implementation
  smear reduction .................................. 136
Import data from column ....................... 50
info (logging file) ................................ 106
Input/Output pins ................................ 48
input/output pins
  configure ......................................... 104
Input/Output pins (section) ........................................ 104
installing
  FirePackage ......................................... 17
  IEEE 1394 adapter ....................................... 16
  SmartView ........................................... 17
Integration enable delay ........................................... 103
Integration enable delay (IntEna) .................................. 47
IntegrationEnable ............................................ 105
Intel Speed Stepping ........................................... 124
IntEna ....................................................... 47
internal trigger ............................................. 102
  continuous mode ....................................... 102
Internal (continuous output) ...................................... 46
Invert ....................................................... 48
  column .................................................. 105
Invert column .............................................. 48
ISO channel ............................................... 39
ISO speed .................................................... 38

J

JFIF ....................................................... 68
JPE ....................................................... 68
JPEG ...................................................... 68
usage ...................................................... 69
JPG ....................................................... 68

K

Knee points
  HDR Guppy F-036 ....................................... 58
  HDR Martin F-131 ....................................... 59
knee points
  IBIS5B .................................................. 112
KODAK Pike sensors
  channel balance ........................................... 108

L

latency ..................................................... 114
LCAA
  local color anti-aliasing ................................... 64
LCAA+V
  local color anti-aliasing including vertical color smoothing .. 64
Left ....................................................... 40
Legal notice ............................................... 2
less color fringe ........................................... 64
less horizontal and less vertical color fringe ................. 64
less resolution ............................................. 64
level mode (Trigger_Mode_1) .................................... 102
Level mode(1) ............................................. 46
LICENSE.TXT .............................................. 19
licensing .................................................... 19
load/save camera settings
  XML files ................................................ 73
local color anti-aliasing
  LCAA ..................................................... 64
local color anti-aliasing including vertical color smoothing
  LCAA+V .................................................. 64
Lock image capture ............................................ 52
log file ..................................................... 106
log levels ................................................... 106
logging ...................................................... 106
logging facility for errors .................................... 106
logging file ............................................... 106
logging functionality
  how to use .............................................. 107
look-up table
  user-defined .......................................... 85
Lookup tables .............................................. 49, 50
Look-up tables (LUT)
  example ................................................ 84
Low act. .................................................... 46, 103
Low (status) ............................................... 105
lower and upper limit ....................................... 43
LUT
  AVT spreadsheet ........................................ 86
  built-in (SmartView) ..................................... 87
  example ............................................... 85
  gamma ................................................... 85
LUT file ..................................................... 50
LUT operation on .......................................... 49
LUT # ...................................................... 49
LUT/Shdg. tab ............................................. 49
LUT/Shdg. (SmartView tab) .................................... 26

M

Magenta/Yellow ............................................. 66
  slider .................................................... 45
manual white balance
  histogram ............................................... 77
Marlin F-131
HDR mode ........................................ 112
matrix ........................................... 54
matrix elements ................................ 56
MaxBPP ......................................... 123
MaxFPS .......................................... 123
maximum theoretical frame rate .......... 40
Microcontroller ............................... 52
Micron MV022
HDR mode ....................................... 111
Mirror image .................................... 51
Mode
Trigger ......................................... 46
Mode column .................................. 48
MONO12 ....................................... 71, 72
MONO16 ....................................... 71, 72
Mono8 mode ................................... 63
motion blur
Trigger_Mode_0 ............................... 104
moving objects
Trigger_Mode_0 ............................... 104
Trigger_Mode_1 ............................... 104
MS low level device driver ............... 115
MSB-aligned .................................. 72
MSXML parser .................................. 73
multi-camera environment ................ 125
Multi-shot
SmartView ..................................... 27
Multishot counter ............................. 46, 103
Multi_shot counter ............................ 104

N
no color fringe .................................. 64
no color information ......................... 64
non-uniform illumination ................... 80
Number of digits ............................. 71

O
Off .................................................. 105
offset
800h ............................................. 41
OHCI chip ...................................... 115
One-shot
SmartView ..................................... 27
oneshot
Trigger_Mode_15 ............................. 102
opening aperture ............................ 77
operating system
FirePackage ................................... 16
Order Number ................................. 52
overview
Edit settings window ...................... 37
FirePackage ................................... 16

P
Packed 12-Bit Mode .......................... 71
only 2x2 Debayering ........................ 130
Packed 12-bit Mode ......................... 135
Packed 12-bit Mode (screenshot) ........ 130
Packed 12-Bit modes ....................... 130
Packet size .................................... 40
packet size
isochronous packets ....................... 40
Parity ........................................... 53
PC debayering ................................. 63
PCI ............................................. 114
PCI Express .................................... 114
PCI latency problems ...................... 124
PCI (Express) bus bandwidth ............. 124
Period column ................................. 48
Pike channel balance ...................... 108
pixel correction ............................. 60
PNG ........................................... 68
usage ........................................... 69
Polarity ......................................... 103
see Invert ................................... 48, 105
Polarity bit ..................................... 105
polarity bit ..................................... 48
Poll the I/O state ......................... 48
Poll the I/O state continually .......... 105
problems
CPU resources ............................... 124
power consumption reduction .......... 124
Processing options ......................... 71
programmable mode (Trigger_Mode_15) 102
Progr. mode(15) .............................. 46, 103
Properties dialog
SmartView ...................................... 107

R
raw ................................................ 68
RAW12 ......................................... 71, 72
RAW12 mode .................................. 63
RAW16 ......................................... 71, 72
RAW16 mode .................................. 63
RAW8 mode ........................................ 63
rd ...................................................... 62
read .................................................. 62
Receive ........................................... 53
receive OHCI chip ................................. 115
Receive-FIFO ................................. 114
Receiver on ........................................ 53
Record every x. frame ....................... 71
Recording options ............................ 68
Rising .............................................. 46, 103
RLE ................................................ 62
rw column ........................................ 62

S
S100 .................................................. 38
S200 .................................................. 38
S400 .................................................. 38
S800 .................................................. 38
Saturation ........................................ 42, 44
definition ........................................ 42
saturation ........................................... 63
Save data to flash .............................. 60
save images ..................................... 68
Save to flash .................................... 50
saving and streaming images .......... 68
saving images
    hard disk, network drive ........... 68
scenarios
    trigger modes .............................. 104
secure image signature (SIS) ........... 134
Secure image signature (SIS) & counters 54
Send images ................................ 52
SeqReset ...................................... 133
SeqStep ....................................... 133
Sequence dialog .................................. 132
Sequence editor .............................. 132
sequence mode (definition) ............... 131
Serial number ................................ 52
Serial port off ................................ 53
Serial port (IIDC-1.31) ..................... 53
Set No ............................................ 55
setting AOI (Format_7 settings)
    example .................................... 120
shading .......................................... 77
    correction data .................................... 79
Shading correction ....................... 50
shading correction .......................... 77
definition ....................................... 77
Shading data file ............................ 50
shading image ............................... 77, 79, 80
generation .................................. 82
shading reference image ................. 81
sharpness ......................................... 42
Show AOI (check box) ...................... 43
Show correction data image ............ 60
Show shading data ......................... 50
shutter ........................................... 41
Shutter column .............................. 133
SIS ............................................... 134
secure image signature .................... 134
slowest algorithm .......................... 64
SmartView
    Adv 1 (tab) ................................. 26
    Adv 2 tab ................................... 26
    Adv 4 tab ................................... 26
    Control 1 (tab) ........................... 26
    Control 2 (tab) ........................... 26
    Control 3 (tab) ........................... 26
    Direct register access ................. 27
    DirectAccess ................................ 27
    Edit Settings ............................... 26
    first steps .................................. 20
    Format (tab) ................................. 26
    further steps ................................ 26
    installing .................................. 17
    LUT/Shdg. (tab) ............................ 26
    Multi-shot .................................. 27
    One-shot .................................... 27
    Properties dialog ....................... 107
    Start iso ................................... 27
    starting .................................... 18
    Trigger/I0 (tab) ........................... 26
    SmartView counters ...................... 125
SmartView feature
    not camera feature .................. 33, 38, 39, 40, 44, 59
SmartView.cmd file ......................... 107
SmartView.exe -i ............................. 107
SmartView’s built-in LUTs .............. 87
smear
    compensate ................................ 136
    smear reduction ......................... 136
    implementation .......................... 136
    smear (definition) ....................... 136
    Software features ...................... 56
    Start iso
        SmartView .............................. 27
    starting
SmartView .............................................. 18
State column ........................................... 48, 105
Status bar .................................................. 123
status bar
  display of frame rate .............................. 123
status bar counters ................................. 124
Std. shutter timebase ............................... 51
Stop bits ................................................ 53
streaming images ..................................... 68
styles ..................................................... 13
sub-sampling
  Format_7 mode mapping .......................... 126
surveillance ............................................. 104
SW trigger .............................................. 103
symbols ................................................. 13

T

tagged image file format
  TIFF .................................................... 69
target grey level ...................................... 41
technical background
  channel balance (Pike) ......................... 108
  HDR (Guppy F-036) ............................... 111
Test images ............................................. 51
three knee points
  IBIS5B .............................................. 112
  TIF ................................................... 68
  TIFF ................................................ 68
  usage .............................................. 69
timebase .............................................. 51
Top ...................................................... 40
transmission errors ............................... 124
Transmit .............................................. 53
Transmitter on ....................................... 53
Trigger ................................................ 46, 103
trigger ................................................ 101
  bulk .............................................. 102
  internal .......................................... 102
trigger and input/output
  example ............................................ 101
trigger count ....................................... 134
Trigger Counter .................................... 54
Trigger delay ....................................... 46, 103
trigger modes
  configure ........................................... 103
  description ...................................... 102
  typical scenarios ................................ 104
Trigger/IO (SmartView tab) ..................... 26
  Trigger_Mode_0 ..................................... 102
    bright illumination ................................ 104
    scenarios ........................................ 104
  Trigger_Mode_0 (edge mode) .................... 102
  Trigger_Mode_1 ..................................... 102
    scenarios ........................................ 104
  Trigger_Mode_1 (level mode) .................... 102
  Trigger_Mode_15 ................................... 46
    scenarios ........................................ 104
  Trigger_Mode_15 (bulk trigger) ............... 102
  Trigger_Mode_15 (programmable mode) ....... 102
  Trig/IO ............................................ 26
  Trig/IO tab ....................................... 46, 101
troubleshooting .................................... 25
TSB12LV26
  block diagram .................................... 115
typical scenarios
  trigger modes ..................................... 104

U

Use deep images ..................................... 68
User sets (Memory channels) ..................... 55
using deep images ................................ 71

V

Value column ......................................... 62
Version information ................................ 52
vertical color fring ................................ 64
video Format_7
  AOI ............................................... 121
Voltage #1
  HDR Guppy F-036 ................................ 58
Voltage #2
  HDR Guppy F-036 ................................ 58

W

-w (logging file) ..................................... 106
warning (logging file) ............................ 106
white balance ....................................... 42
  advanced (Guppy color interlaced) ............ 66
  automatic ......................................... 42
  manual ............................................ 42
  register 80Ch .................................... 42
Width ................................................ 40
Width column ....................................... 48
Windows RGB ........................................ 65
WPARAM_ERROR message ........................... 118
wr.......................... 62
write.......................... 62

X
XML ........................................... 73
  (eXtensible Markup Language) ........... 73
XML files (load) ......................... 73
XML files (save) ....................... 73

Y
Yellow/Green............................. 66
  slider.................................... 45
YUV space............................... 65
YUV422 .................................... 64
YUV422 mode............................ 64

Symbols
  *.cmd .................................... 106
  *.cmd file .............................. 107